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实训一  AutoCAD2000的启动与退出 

[目的要求]:掌握 AutoCAD2000的启动与退出 

一．启动 

1.使用“开始”菜单启动 AutoCAD2000 

①执行“开始”→“程序”→“AutoCAD2000”→“AutoCAD2000英文版”

图标 

②左键双击图标，主界面被打开 

2．使用快捷方式启动 AutoCAD2000 

①双击 AutoCAD2000快捷图标 

②屏幕进入 AutoCAD2000工作界面 

3．使用资源管理器启动 AutoCAD2000 

①执行“开始”→“程序”→“Windows资源管理器”命令，弹出“浏览”

对话框 

②选择 AutoCAD2000所安装的路径 c:\Program Files\AutoCAD2000然后

选中 acad.exe应用程序 

③右击鼠标在弹出的快捷菜单中选择“打开”命令或双击“acad”图标，

AutoCAD2000主界面被打开 

二．退出 

1．执行“File”→“Quit”命令关闭 AutoCAD2000 

2．在状态栏下输入命令，然后按回车键，退出 AutoCAD2000 

3．单击主界面右上角的“X”按纽，关闭 AutoCAD2000 
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实训二  添加和删除菜单 

[目的要求]:通过菜单编组添加和删除菜单 

一．添加“夹点光标菜单” 

1．执行“工具 Tools”“自定义菜单 Customize Menus”命令，弹出自定

义菜单对话框“Menu Customization ” 

2．单击菜单栏“Menu Bar”选项卡，从左侧的“菜单”列表框中选中夹

点光标菜单“Object Snap Cursor Menu”选项，并单击插入“Intert”

按纽 

3．“Object Snap Cursor Menu”选项被加入到右侧的菜单栏列表中，然

后单击“关闭”按纽 

二．删除“绘图”菜单 

执行“Tools”→“Customize Menus”→“Menu Customization”, 

单击菜单栏“Menu Bar”选项卡，从右侧的“菜单栏”列表框中选中“绘

图”选项，再单击删除“Remove”按纽。 

“绘图”选项在“菜单栏”列表框中被删除，然后单击“关闭”按纽 

三．当下拉菜单中缺少＂工具 Tools＂菜单时，如何补救？ 

1．在命令行“Command”后面输入“Menu Load”菜单路径字符，这时出

现“Menu Customization”. 

2.按上面添加菜单方法，把“Tools”菜单添加到右边菜单栏列表框中“关

闭”按纽. 

四．当主界面丢失所有菜单文件时，如何补救？ 

PDF 文件使用 "pdfFactory Pro" 试用版本创建 www.fineprint.cn

http://www.fineprint.cn
http://www.fineprint.cn


第 5 页 共 105页 

在命令行“Command”后面输入“Menu”，出现“Support”对话框 

选中文件名为“acad”文件，按“打开”键 

实训三  工具条的设置 

[目的要求]:掌握工具中的添加、删除、制作新的工具条、定义工具条的 

弹出特性 

一．打开“工具条”对话框 

从“View”菜单中选中“Toolbars”选项，弹出“Toolbars”对话框，左

键点击工具条前面方框“□”使之变为“X”即此工具条被打开 

移动鼠标箭头到任何一个工具按纽上，点击鼠标右键，弹出 24 个标准工

具条，在选中工具条前面点击一点，出现“√”即打开此工具条 

二．制作新的工具条。如“文字” 

1．“View”→“Toolbars”，弹出“Toolbars”对话框 

2．左键点取“New”按纽，弹出“New Toolbars”对话框 

在“Toolbar Name”中输入要建立的工具条名称，如“文字”，点击“OK”。

此时屏幕上出现一个空白的“文字”工具条 

3.向“文字”工具条中添加工具按纽。单击“Toolbars”对话框右边

“Customize”自定义按纽，出现“Customize Toolbars”对话框。在类

别中选择“Draw”，将有关文字的三个小图标（多行文字）、（单行文字）、

（动态文字）拖动到新建的空白“文字”工具条中，这样新的工具条便制

成了。 

4.如想删去“ ”按纽，则从“文字”工具条中把“ ”按纽拖回“Draw”
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类别中 

三．定义工具条的弹出特性（也称嵌套式工具条） 

嵌套式工具条是一组工具条按纽的组合，当用户用鼠标单击它时，将弹出

一系列按纽供您选择，可以通过“Flyout Properties”对话框定制嵌套

式工具条 

1.在“Toolbars”对话框中，点击“Customize”选项，出现“Customize 

Toolbars”对话框 

2.从类别中选择“Custom”选项，左键点击“▲”标记，并将其拖动到屏

幕上的“工具条”上。如“绘图”工具条上。 

3.移动鼠标箭头至“▲”标记处，单击右键，出现“Flyout Properties”

对话框 

4.在“Associated Toolbar”中选择类别，如“ACAD Draw”，然后在 name

中输入“Draw”，再在“Button Icom”中选中相应图标如“”，点击“Apply” 

在“绘图”工具条上出现带“▲”标记的工具条，即为嵌套式工具条 

实训四  系统的绘图命令操作 

[目的要求]：1.掌握点、直线、圆、圆弧命令的使用 

2.掌握图层特性管理对话框设置 

3.掌握正交模式“Ortho”及捕捉模式“Osnap”使用 

一．绘制“例一”图形 

1． 在图层特性管理对话框中设置中心层为点划线，线宽为 0.2mm；粗实

线层为连续线，线宽为 0.6mm 
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2．打开状态栏正交模式“Ortho”，作互相垂直两根中心线 

Command:_Line specify first point:        任取一点 

Specify next point or [Undo]:@70,0        绘制中心线“ab” 

Command:_Line specify first point:       在直线“ab”上任取一点 

Specify next point or [Undo]:@0,100       绘制中心线“cd” 

3．采用圆心、半径绘制 Ø30圆，打开状态栏对象捕捉模式“Osnap” 

Commad:_Circle specify center point for circle or [3P/2P/Ttr(tan 

tan radius)]:< Osnap On>    捕捉中心线“ab”与“cd”交点“o” 

Specify radius of circle or [Dianeter]:15           输入半径“15” 

4．采用圆心、起始点、角度形式绘制圆弧 R30 

Comand:_arc specify start point of arc or [Center]:C 输入圆心“c” 

Specify  center point of arc:                      捕捉圆心 

Specify start point of arc:@30,0  采用相对坐标形式得“b”点坐标 

Specify end point of arc or [Angle/Chord tength]:A 
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                                           采用角度形式画圆弧 

Specify include angle:180°                  输入圆弧为 180° 

5．绘制直线 a12-23-34-45-56-67-7b，利用正交模式“ORTHO”绘直线 

Command:_Line specify first point:            捕捉点“a” 

Specify next point or [Undo]:60               输入点“2”坐标 

Specify next point or [Undo]:15               输入点“3”坐标 

Specify next point or [Undo]:10               输入点“4”坐标 

Specify next point or [Undo]:30               输入点“5”坐标 

Specify next point or [Undo]:10                输入点“6”坐标 

Specify next point or [Undo]:15                输入点“7”坐标 

Specify next point or [Undo]:60                输入点“b”坐标 

Specify next point or [Undo]:↙                 回车结束命令 

6．绘制直线“ef”，采用捕捉相对基点的偏移形式 

Command:_Line specify first point:From 

使用“From”捕捉相对基点的偏移点 

Base point:Int of             使用“Int”捕捉交点（2）作为基点 

<offset>:@0,20 ↙               输入点（e）的相对基点的偏移量 

Specify next point or [Undo]:per of     使用“per”捕捉垂足点（F） 

Specify next point or [Undo]:↙         回车结束命令 

7．保存文件 

File--save--d：、autoCAD2000--输入文件名“例一”保存。 

二、练习题 
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（1）                          

（2） 

 

三、作出下列图形： 

1．已知△ABC 三点坐标 A（45，125）、B（95，210）、C（145，125）。作

该三角形的内切圆和外接圆。 

2．已知圆 A，圆心为（45，150），半径为 24；圆 B，圆心为（130，150），

半径为 35，作圆 A、B两条外公切线。 

3．已知 A（50，180）、B（75，140）、D（150，140），直线 BC 分别是弧
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形 AB和弧 CD的切线，且弧 AB角度为 180°，BC长为 50个单位。 

4．以 O（130，145）为圆心作一半径为 50的圆，过点 A（30，145）分别

作出切线 AB和 AC。另作一圆分别相切于 AB和 AC，半径为 20。 

5．①过点 A（45，55）和点 B（130，195）作一条直线，过点 A 作直线

AC。已知 AB=AC，∠BAC=45°，C点在 B点下方。②过点 B和点 C作一圆

分别相切于直线 AB和 AC。 

6．过点 A（115、210）、B（45、150）、C（150，105）作三角形，作出三

角形三个角的角平分线（Bisect）查出三条角平分线交点的坐标。 

实训五  绘图命令操作（二） 

〔目的要求〕: 

1.掌握矩形、多边形命令的使用。 

2.掌握 pline命令的使用。 

一． 绘图例二图形 

1．利用 pline命令绘制外边框，从“1”点开始按顺时针方向作图 

command:_pline. 

Specify start poind:             任取一点 a 

Current line-width is 0.0000      当前线宽为 0.0000 

Specify next point or [Arc/close/Halfwidth/Legth/undo/width] :A 

                                                绘制圆弧 

Specify endpoint of arc or[Angle/CEnter/close/Direction/Halfwidth 

/Line/Radius/Second pt/undo/width]A           输入圆弧包含角度 
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Specify included angle: -90 

Specify endpoint of arc or [cEnter/Radius]: r      输入圆弧半径 

Specify radius of arc:16                      圆弧半径为 16 

         

Specify direction of chord for ace<0>:45 

                                     圆弧弦的方向为 45°得点 b 

Specifyend point of arc or[Angle/CEnter/close/Direction/Halfwidth 

/Line/Radius/Second pt/undo/width]: L          转为画直线 

Specify next point or[Arc/close/Halfwidth/length/undo/width]: 

<ortho on>32.                         输入长度为 32直线得点 c 

Specify next point or[Arc/close/Halfwidth/length/undo/width]:30 

                                       输入长度为 30直线得点 d 

Specify next point or[Arc/close/Halfwidth/length/undo/width]:16 

                                        输入长度为 16直线得点 e 

Specify next point or[Arc/close/Halfwidth/length/undo/width]:30 

                                        输入长度为 30直线得点 f 

Specify next point or[Arc/close/Halfwidth/length/undo/width]:32 
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                                        输入长度为 32直线得点 g 

Specify next point or[Arc/close/Halfwidth/length/undo/width]: a 

                                                    输入圆弧 

Specify included angle :-90                 圆弧旋转角度为-90° 

Specify endpoint of arc or[CEenter/Radius]: r  输入圆弧半径为 16 

Specify radius of arc: 16 

Specify direction of chord for arc<0>:-45  

                                        圆弧弦方向为-45°得点 h 

Specify endpoint of arc or[Angle/Center/Close/Direction/Halfwidth 

/Line/Radius/Second pt/undo/width]: L          转换为绘制直线 

Specify next point or[Arc/close/Halfwidth/length/undo/width]: 

<ortho on>44                         输入长度为 44直线得点 i 

Specify next point or[Arc/close/Halfwidth/length/undo/width]:112 

                                       输入长度为 112直线得点 j            

Specify next point or[Arc/close/Halfwidth/length/undo/width]:44 

                                   输入长度为 44直线得点 a 

Specify next point or[Arc/close/Halfwidth/length/undo/width]: ↙ 

                                             回车结束 pline命令 

Command:_circle specify center point for circle or[3p/2p/Ttr(tan 

tan radins)]:<osnap on>       捕捉圆弧 R16的圆心，绘制φ16的圆 

Specify radius of circle or[Diameter]:8 ↙ 

Command:_circle  作另一φ16的圆（同上，过程略） 
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Command:save  命名为“例二” 

二、绘制“例三”图形 

1．绘制矩形 

Command:_rectang 

Specifyfirstcorner.pointor[chamfer/E/evation 

/Fillet/Thickness/width]:C                       设置矩形倒角                                       

Specify frist chamfer distance for rectang les<0.00>:10   

                                            取矩形倒角边为 10 

Specify second chamfer distance for Fectangles<10.0> ↙   

                                     取矩形第二倒角边为 10 

Specify first corner point or[Chamfer/ E/evation /Fillet/ 

Thickness/width]:                       任取一点为矩形左下角点 

Specify othe corner point: ＠120.80   

                    利用相对坐标形式得矩形右上角绘制多边形 

1．绘制多边形 

Command:_polygon Enter number of sides<4>: 7 指定多边形为 7边形 

Specify center of polygon or[Edge]: e   

                               通过多边形的边“ab” 绘制多边形 

Specify first endpoint of edge:<osnap on>  捕捉“a”点 

Specify second end point of edge:  捕捉“b”点，结束命令 

Command:save    
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三、练习题 

四、作下列图形： 

1．过点 A（40，105）、B（165，190）两点作一矩形，以矩形的中心点为

中心，以矩形的两边长为长短轴作一椭圆。 

2．作出 ABCDE多义线。已知 A点坐标为（30，175），E点坐标为（130，

120），A、B、C、D四点在同一水平线上，线段 AB线宽为 0，长度为 40，

线段 BC长度为 30，B点线宽为 40，C点线宽为 0，线段 CD长度为 30，D

点线宽为 20，弧 DE的宽度为 20，线段 CD在 D点与弧 DE相切。 

3．作边长为 50的正六边形，并作出正六边形的内切圆和外接圆。 

4．以点（100，150）为中心，作一边长为 40的正方形，在该正方形的外
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边作两个正方形，外边的正方形四边的中点是里边的正方形的四个顶点。 

5．以点（100，155）为圆心作一半径为 20的圆，再作一半径为 60的同

心圆。以圆心为中心，作两个互相正交的椭圆，椭圆短轴为小圆半径，长

轴为大圆半径。 

实训六  绘图命令的操作（三） 

〔目的要求〕 

熟悉 break命令，Trim命令 

掌握 Array，Divide命令使用 

掌握区域填充命令的使用 

一、绘制“例四”图形 

1、设置点格式为可见 

点击 Format→Point style，出现“point style”对话框，选一可见点，

点击 OK 

2、绘制互相垂点两中心线 

3、绘制φ90圆 

command_circle specify center point for circle or[3p/2p Ttr(tan tan 

radius)]:<osnap on>                               捕捉圆心 O 

Specify radius of circle or[Diameter]:45  输入半径为 45 

4、绘制点（1） 

command:_point 

specify a point:                                 捕捉（1）点 
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5、利用 Array命令等分φ90圆为五等分 

command:_array 

select objects:                               用方框框住点（1） 

select objects: ↙ 

Enter the type of array[Rectangulat/polat]<R>:P  

                                              指明进行圆形阵列 

Specify center point of array:   捕捉圆心 O 

Enter the number of items in the array:5     输入阵列数目 

Specify the angle to fill(+=ccw,-=cw)<360>:↙ 

                                             指定阵列角度为 360

° 

Rotate arrayed objects?[yes/no] <Y>:         确认复制时旋转对象 

6、将对应点连接为多边形 

Command:_line specify first point:                 捕捉（1）点 

Specify next point or[undo] <ortho off>            捕捉（3）点 

Specify next point or[undo]: ↙                    结束命令 

同理将：14、25、53、24连接成直线，构成五边形。 

7、利用 Break命令打断交叉线段 

Command:break select object:                    点取直线“13” 

Specify second break point or[First point]: F  指定打断第一点 

Specify first break point:                           捕捉点 6 

Specify second break point:             捕捉点 7，打断“67”段 
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同理，用 Break打断直线“7 8”、“8 9”、“9 、10”、“10 、6” 

8、区域填充 

（一）下拉菜单 Draw→surfaces→2D Solid.或命令行直接输入 Solid 

Command:_solid specify first point:   捕捉（1）点 

Specify second point:  捕捉（6）点 

Specify third point:  捕捉（3）点 

Specify fourth point or <exit>:  捕捉（8）点  填充三角形“1 3 8” 

同理填充“2 7 6”、“5 9 10”“1 4 8” 

                           

（二）绘制锐刀平面图（例五） 

（1）绘制互相垂直中心线 

（2）绘制φ25圆及φ50、φ94、φ70圆 

（3）键槽绘制 

Command:_line specify first point from  

                              使用“From”捕捉相对基点的偏移点 

Base point:<osnap on>                             捕捉基点（a） 
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<offset>:＠0,28利用相对坐标形式得“b”点坐标 

Specify next point or[undo]: 4             输入水平向左距离为 4 

Specify next point or[undo]: 4             输入垂直向下距离为 4 

同理画出键槽右边 

Command_Trim select cutting edges 

Select objects:                       用方框形式框住要修剪的边

界 

Select objects: ↙ 

Select objects to trim or[project/Edge/undo]:     

                                         将需要修剪边界进行修剪 

（4）利用 Divide命令将φ70、φ90圆等分为 10等分 

a.先将点形式设为可见  Format→point style 

b.command:_divide 

select object to divide:   捕捉φ70的圆 

Enter the number of segments or[Block]:10 ↙        输入等分数目 

c.同理等分φ90的圆为 10等分 

（5）绘制顶端齿形 

Command:_pline 

Specify start point:<osnap on>                    捕捉（1）点 

Specify next point or[Arc/Close/Halfwidth/Length/undo/width]: 

<ortho off>                                       捕捉（2）点 

Specify next point or[Arc/Close/Halfwidth/Length/undo/width]: A 
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                                                  指定绘制圆弧       

Specify end point of arc 

or[Angle/Center/Close/Direction/Halfwidth 

/Line/Radius/Second pt/undo/width]: CE            指定捕捉圆心 

Specify center point of arc:                      捕捉圆心（0） 

Specify endpoint of arc or[Angle/Length]: L       指定圆弧段弦长 

Specify length of chord: 10 弦长为 10 

Specify end point of arcor[Angle/Center/Close/ Direction 

/Halfwidth/Line/ Radius/Second pt/undo/width]: R    定义弧半径 

Specify radius of arc:53                              半径为 53 

Spcify endpoint of arc or[Angle]:                   捕捉终点（3） 

（6）阵列其它齿形，整圆等分为 10个齿形 

（7）删除φ90的圆，存盘为“例五”。  
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（三）“例六” 图形 

参考步骤： 

1．作圆φ60 

2． 作斜线α＝14.48°，利用相对极坐标“b”相对于“a”的坐标为 

   ＠35＜104.48°作圆弧 R2.5 

3．利用 Array得φ60上 7个 R2.5的圆弧 

4．作斜线 cd，利用相对极坐标“d”相对于“c”坐标为＠50＜35.56° 

 

5．R10的圆弧与 R2.5的圆弧及斜线 cd相切 

6．圆“e”与二段 R10的弧及斜线 ab相切 

7．φ4的圆与圆“e”属同心圆，利用 Array可得 5个φ4的圆 

（四）、作出下列图形：                      

1．点 A（35，115）和点 B（165，210）作直线 AB，点 C和点 D将直线 AB

分成三等分，分别以 C、D为圆心作圆，使两圆相切于直线 AB的中点。 

2．以点 C（95，145）作一半径为 50的圆，作 5个半径为 10的小圆，将

PDF 文件使用 "pdfFactory Pro" 试用版本创建 www.fineprint.cn

http://www.fineprint.cn
http://www.fineprint.cn


第 21 页 共 105页 

半径为 50的大圆分成五等分。 

3．以点（100，160）为圆心，作半径为 70的圆，在该圆中作出四个呈环

形均匀排列的小圆，小圆半径为 15，小圆圆心到大圆弧线的最短距离为

25。 

4．以点（90，160）为圆心，作一半径为 50 的内接三角形，分别以三角

形三边的中点为圆心，三角形边长的一半为半径，作三个互相相交的圆。 

5．以点（90，160）为圆心，作一半径为 60 的圆，在圆周上均匀作出八

个边长为 10的正边形，且正方形的中心点落在圆周上。  

(五)、练习题 

实训七  编辑命令的使用 

[目的要求〕 

掌握 Fillet命令使用 
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掌握 offset，Lengthen命令使用 

一．作"例七"图形 

1.作互相垂直两中心线，交于点 O 

2.作 R1.5，R2的圆 

 

 

3.作斜线 oa，a点相对于 O点坐标为＠2.5＜45° 

4.利用 offset命令，使 oa向两边各偏移 0.5距离 

Command:_offset 

Specify offset distance or[Through]<Through>:0.5  

                                            输入偏移距离为 0.5 

Specify object to offset or<exit>:                指定线段 oa 

Specify point on side to offset:            点击 oa上面任一点 

Specify object to offset or<exit>:                指定线段 oa 

Specify point on side to offset:       点击 oa下面任一点，回车 

5.利用 Trim命令修剪图形 
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command:_Trim 

select cutting edges 

select objects:                                    选择所有图形 

select objects: ↙ 

select object to trim or[project/edge/undo]:     选择被修剪对象 

6.利用 Break打断 R1.5的圆 

command:Break  

select object:                                    选择 R1.5的圆 

specify second break point or[First point]:      选择圆上另一点 

结果如下图所示： 

7.利用 Array命令阵列成 360°，阵列数目为 3 

8.利用 Lengthen命令延长线段，进行整合 

command:_Lengthen 

select an object or[Delta/percent/total/Dymamic]:DY   

                               使用 “DY”选项动态改变直线的长度 

select an object to change or[undo]:  
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                                    选中直线一端进行拖动到合选

点 

9、利用 Fillet命令进行倒圆角 

command:_Fillet 

select first objet or[polyline/Radins/Trim]: r   改变倒圆角半径 

specify fillet radius<10>:0.25                   改变半径为 0.25 

command :Fillet 

curront settings:Mode=No Trim,Radius=0.25 

select first object or[polyline/Radius/Trim]: T     设定修剪模式 

Enter trim option[Trim/No Trim] <NO Trim>: T      改变为修剪模式 

Select first object or[polyline/Radius/Trim/:    

                               选择要修剪的两根线，直到修剪完成  

二．作课本例题“图 3-43” 

1.定基准，以右边界为基准 

2.利用 offset命令，得泵轴各段距离 

3.利用 Trim命令或 Break命令得上半轴 
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4.利用 Mirror命令镜像下半部分 

5.修倒角 2×45° 

command:_chamfer                                    输入倒角命

令 

（No Trim mode）current chamfer Dis1=10.00  Dis2=10.00 

Select first line or[ployline/Distance/Angle/Trim/Method]: D   

                                         以设定倒角长度方式倒角 

Specify first chamfer distance<10.00>:2 ↙   指定第一边倒角距离 

Specify first chamfer distance<10.00>:↙  指定第二边倒角距离为 2 

Command:_ chamfer 

（No Trim mode）current chamfer Dis1=2.00   Dis2=2.00 

Select first line or[ployline/Distance/Angle/Trim/Method]: T    

                                                 设置剪切开关 

Enter trim mode option [Trim/No Trim]<No Trim>: T ↙    

                                        把剪切开关设置为剪切方

式 

Select first line or[polyline/distance/angle/trim/method]:    

                                                   选要倒角一边 

Select second line:                               选要倒角另一边 

6.利用 Modify→properties命令修改线段特性 

选中泵轴中心线（当前假设为连续线），点中 properties图标，将连续线

改为点划线则可。 
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三、作例题“图 3-45” 

 

1．定基准，打开 ortho，利用 offset命令偏移各线段 

2．利用 Trim命令修剪为如图样所示 

3．利用 Fillet及 Chamfer命令修剪圆角及倒圆角 

实训八  编辑命令的使用 

〔目的要求〕 

掌握 mirror命令使用 

掌握 Xline命令使用 

一、 作“例八”所示图形 

利用 line及 offset命令画主视图左半部分 

利用 Trim命令进行修剪 

利用 mirror命令进行镜像，得右半部分 
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Command:mirror 

Select objects: 

Specify opposite corner:     用窗口 1P 2P选择目标（左半部分） 

Specify first point of mirror line:  选择点 a给出镜像上第一点 

Specify second point of mirror line:  选择点 b，ab即为镜像线 

Delete source objects?[Yes/No] <N>:↙  响应“N”不删除原始对象 

利用命令 XLine保证主视图与俯视图长对应 

先绘制俯视图左半部分 

利用 mirror命令得右半部分 

二、作泵体主观图：作泵体上
4
1
椭圆形状，如下图〔图 3-46（1）〕 
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利用 mirror命令，上下镜像得下半部分画上泵体底座 

 

利用 mirror命令把左半部分镜像到右边，成为整体（图 3-46） 

 

 

 

三、练习题 
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实训九  综合练习 

[目的要求]：能把绘图及编辑命令灵活运用，绘制平面图形。 

一 、 图 3-42参考步骤： 

1.定基准，得 Ø17.5的圆心为 O，画 Ø17.5的圆 

2.用 offset命令，得交点 2O 3O 4O  

3.以 2O 为圆心作 Ø26及 Ø39的圆弧 

以 3O
为圆心作 Ø10的圆弧 

以 4O 为圆心作 Ø10的圆弧 

以 5O
为圆心作 R14的圆弧 

4.利用 offset命令得左边直线，交 Ø26的中心线于 a 

5.利用 line命令，画左边四边形 

  打开正交 ortho，画直线 a-b-c-d-e-close 
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6.求 R40的圆心 6O
 

  a 利用 offset，使直线 eab向右偏移 5得直线 1l  

  b 利用 R46与 Ø26的圆弧相外切，求作圆心 

以 2O 为圆心，以 R13+R46=R59为半径作圆，交直线 1l 得圆心 6O
 

7.以圆心 6O
为圆心，R40、R46为半径作两圆弧 

8.利用 Fillet修剪 R9、R4、R7.5等圆角 

9.利用 Trim命令修剪多余线段 

10.利用 Lengthen命令使各中心线的长度最适合 

二.练习题 
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实训十  转臂的绘制 
[目的要求] 综合运用 AutoCAD绘图命令和编辑命令。 

     

                        图 2-39 转臂平面图 

步骤一：建立轮廓线层、尺寸线层和中心线层。其中，中心线层选择

中心线线型，选择公制，选择适当的绘图范围（300×160）。打开绘制、

编辑、对象捕捉、尺寸标注等常用工具条。打开端点、交点、圆心等捕捉

功能 

步骤二：将轮廓线层设成当前层（先把全部图形都绘制在该层，然后

通过图形属性编辑功能一次性转换过去）。通过极轴追踪捕捉功能或偏移

命令，绘制基准线。操作步骤如下： 
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Command：_line                               点击直线绘制命令 

Specify first point：                      在适当位置任取一点 

Specify next point or [Undo]：           绘水平基准线的另一点 

Specify next point or [Undo]：↙         回车，水平基准线已绘好 

Command：↙                            回车，继续绘制垂直基准线 

LINE Specify first point：                   在适当位置任取一点 

Specify next point or [Undo]：             绘垂直基准线的另一点 

Specify next point or [Undo]：↙         回车，垂直基准线已绘好 

Command： 

Command：_offset                                  点击偏移命令 

Specify offset distance or [Through] <Through>：52↙        

                                                  输入偏移距离 

Select object to offset or <exit>：     选择偏移对象，点选垂线 

Specify point on side to offset：        选择偏移方向，点选右边 

Select object to offset or <exit>：↙回车，另一垂直基准线已绘好 

Command：                                 书馆如图 2-40所示（左） 

Command：_circle                                点击绘制圆命令 

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]：                          

捕捉交点 

Specify radius of circle or [Diameter] <5.0000>：10↙  输入半径 

Command：↙                                回车，绘制另一同心圆 

CIRCLE Specify center point for circle or [3P/2P/Ttr (tan tan 

radius)]：                                            捕捉圆心 

Specify radius of circle or [Diameter] <10.0000>：15↙                    

输入半径 

Command：↙                                回车，继续绘制右边圆 

CIRCLE Specify center point for circle or [3P/2P/Ttr (tan tan 

radius)]：                                            捕捉交点 

Specify radius of circle or [Diameter] <15.0000>：5↙                

输入半径 

Command：↙                        回车，继续绘制右边另一同心圆 

CIRCLE Specify center point for circle or [3P/2P/Ttr (tan tan 

radius)]：                                             捕捉圆心 
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Specify radius of circle or [Diameter] <5.0000>： 9↙                

输入半径 

Command：                                     如图 2-40所示（右） 

 

                  

图 2-40  绘制基准线与圆 

 

    步骤三：绘制两圆的切线和中间连线。操作步骤如下： 

Command：_line                                点击直线绘制命令 

Specify first point：_tan to                捕捉左边外圆上切点 

Specify next point or [Undo]：_tan to       捕捉右边外圆上切点 

Specify next point or [Undo]：↙           回车，上面切线已绘好 

Command：↙                            回车，继续绘制直线（切线） 

LINE Specify first point：_tan to            捕捉左边外圆下切点 

Specify next point or [Undo]：_tan to        捕捉左边外圆下切点 

Specify next point or [Undo]：↙           回车，下面切线已绘好 

Command：↙                                  回车，继续绘制直线 

LINE Specify first point：_cen of    利用极轴捕捉，以圆心为基准 

Specify first point or [Undo]：2.5↙       向上 2.5，从右边开始 

Specify next point or [Undo]：               捕捉左边与圆的交点 

Specify next point or [Undo]：↙          回车，上面连线已绘好 

Command：↙                                回车，继续绘制直线 

LINE Specify first point：_cen of    利用极轴捕捉，以圆心为基准 

Specify first point or [Undo]：2.5↙       向下 2.5，从右边开始 

Specify next point or [Undo]：               捕捉左边与圆的交点 

Specify next point or [Undo]：↙           回车，下面连线已绘好 

Command：                                        如图 2-41所示 
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图 2-41  绘制切线与中间连线 

步骤四：整理图中线条。修剪中间连线，修整三条基准线 

Command：_trim                                  点击修剪命令 

Current settings： Projection=UCS Edge=None 

Select cutting edges ...                           选择修剪边界 

Select objects：1 found                            点选右边外圆 

Select objects：↙                               回车，结束选择 

Select object to trim or [Project/Edge/Undo]：    

                               选择需要剪掉的部分，点选连线右端 

Select object to trim or [Project/Edge/Undo]： 点选另一连线右端 

Select object to trim or [Project/Edge/Undo]：↙ 回车，结束修剪 

Command：                                     如图 2-42所示（左） 

 
图 2-42  整理图中线条 

Command：_break                                   点击打断命令 

Select object：                              选中水平基准线 A点 

Specify second break point or [First point]：           

                                           点击 A点以右的端点外 

Command：↙                        回车，继续打断（修整）基准线 

BREAK Select object：                        选中垂直基准线 B点 

Specify second break point or [First point]：点击 B点以上端点外 

Command：↙                        回车，继续打断（修整）基准线 

BREAK Select object：                    选中另一垂直基准线 C点 

Specify second break point or [First point]：点击 C点以上端点外 

Command：↙                        回车，继续打断（修整）基准线 
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BREAK Select object：                        选中水平基准线 D点 

Specify second break point or [First point]：点击 D点以左端点外 

Command：↙                        回车，继续打断（修整）基准线 

BREAK Select object：                        选中垂直基准线 E点 

Specify second break point or [First point]：          

                                           点击 E点以下的端点外 

Command：↙                        回车，继续打断（修整）基准线 

BREAK Select object：                        选中垂直基准线 F点 

Specify second break point or [First point]：点击 F点以下端点外 

Command：                                     如图 2-42所示（右） 

    步骤五：镜像图形。将右边的两同心圆、上下切线和中间两条连线镜

像到左边 

Command：_mirror                                   点击镜像命令 

Select objects：                         用交叉窗口选择右侧图形 

Specify opposite corner：8 found               选中 8个图形对象 

Select objects：↙                               回车，结束选择 

Specify first point of mirror line：           捕捉镜像线上端点 

Specify second point of mirror line：          捕捉镜像线下端点 

Delete source objects? [Yes/No] <N>：↙        回车，保留原图形 

Command：                                    如图 2-43所示 

 

图 2-43  镜像后的图形 

 

步骤六：旋转图形。将刚镜像到左边的图形顺时针旋转 96度 

Command：_rotate                                 点击旋转命令 

Current positive angle in UCS：ANGDIR=counterclockwise  ANGBASE=0 

Select objects：                         用交叉窗口选择右侧图形 

Specify opposite corner：8 found               选中 8个图形对象 

Select objects：↙                              回车，结束选择 

Specify base point：                     捕捉旋转中心（中间圆心） 

Specify rotation angle or [Reference]：-96↙     回车，结束选择 
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Command：                                    如图 2-44所示（左） 

   步骤七：图形倒圆角。将旋转得到的图形右侧切线与图上切线倒圆角 

Command：_fillet                                点击倒圆角命令 

Current settings：Mode = TRIM, Radius = 10.0000 

Select first object or [Polyline/Radius/Trim]：r↙       

                                              需要改变圆角半径 

Specify fillet radius <10.0000>：8↙              输入圆角半径 

Command：↙                    回车，继续倒圆角命令，开始倒圆角 

FILLET 

Current settings：Mode = TRIM, Radius = 8.0000 

Select first object or [Polyline/Radius/Trim]：       

                                             选择旋转后右边切线 

Select second object：                         选择原图形上切线 

Command：                                   如图 2-44所示（右） 

 

图 2-44  图形旋转与倒圆角 

步骤八：图形修整。利用图形属性修改对话框将所有基准线改变图层，

使之变成中心线。并选择适当的线型比利，使中心线显示清晰 

Command：_properties     在 Modify中启动 Properties命令如图 2-45 
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图 2-45  在 Properties（图形属性）对话框修改参数 

实训十一   吊钩的绘制 

 
步骤一：建立轮廓线层、尺寸线层和中心线层，选择公制，选择适当

的绘图范围（300×180），打开绘制、编辑、对象捕捉、尺寸标注等常用

工具条，打开端点、交点、圆心等捕捉功能 

步骤二：绘制图形定位基准线。利用极轴追踪捕捉功能，在轮廓线层

绘出图形定位基准线（有时需作必要的辅助线条，如本例辅助直线 EF 和

GH，辅助圆 J和 K）。操作步骤如下： 

Command：_line                                点击绘制直线命令 

 Specify first point：                          捕捉任意一点 A 

Specify next point or [Undo]：              ∥绘制水平基准线 AB 

Specify next point or [Undo]：↙            ∥回车，结束 
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图 2-46  吊钩平面图 

Command：↙                              ∥回车，继续绘制直线 

LINE Specify first point：                       ∥捕捉某点 C 

Specify next point or [Undo]：  绘制垂直基准线 CD，与 AB相交于 O 

Specify next point or [Undo]：↙                 ∥回车，结束 

Command：↙                             ∥回车，继续绘制直线 

LINE Specify first point：5↙      利用极轴追踪从 O点捕捉得 E点 

Specify next point or [Undo]：               ∥绘制辅助直线 EF 

Specify next point or [Undo]：↙             ∥回车，结束 

Command：↙                             ∥回车，继续绘制直线 

LINE Specify first point：9↙    ∥利用极轴追踪从 A点捕捉得 G点 

Specify next point or [Undo]：              ∥绘制辅助水平线 GH 

Specify next point or [Undo]：↙              ∥回车，结束 

Command： 

Command：_circle                               ∥点击绘制圆命令 

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]：   

∥捕捉交点 O 

Specify radius of circle or [Diameter]：36 输入半径，得辅助圆 J 

Command：↙                                ∥回车，继续绘制圆 

CIRCLE Specify center point for circle or [3P/2P/Ttr (tan tan 

radius)]：  ∥捕捉交点 E 

Specify radius of circle or [Diameter] <36.0000>：43↙       

                                           输入半径，得辅助圆 K 

Command：                                       如图 2-47所示。 

圆 J与直线 GH的交点 S就是中间圆弧 R24的圆心，而圆 K与直线 AB
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的交点 T就是中间圆弧 R14的圆心。 

 

图 2-47  绘制基准线 

 

步骤三：绘制已知线段。在得到 S 和 T 点后（用小圆作个标记），可

删去辅助圆 J和圆 K。利用图中给定的尺寸绘出吊钩上部 Ø14、Ø18的轮
廓线和圆 R29、Ø 24。操作步骤如下： 

Command：_circle                              ∥点击绘制圆命令 

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]： 

∥捕捉交点 O 

Specify radius of circle or [Diameter] <43.0000>：12↙    

                                 ∥以 O为圆心，12为半径，得圆 1 

Command：↙ 

CIRCLE Specify center point for circle or [3P/2P/Ttr (tan tan 

radius)]：                                       ∥捕捉交点 E 

Specify radius of circle or [Diameter] <12.0000>：29↙   

                                ∥以 E为圆心，29为半径，得圆 2 

Command：↙ 

CIRCLE Specify center point for circle or [3P/2P/Ttr (tan tan 

radius)]：                                           ∥捕捉点 S 

Specify radius of circle or [Diameter] <29.0000>：24↙    

                                 ∥以 S为圆心，24为半径，得圆 3 

Command：↙ 

CIRCLE Specify center point for circle or [3P/2P/Ttr (tan tan 

radius)]：                                          ∥捕捉点 T 
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Specify radius of circle or [Diameter] <24.0000>：14↙   

                                 ∥以 T为圆心，14为半径，得圆 4 

Command： 

Command：_line Specify first point：54↙   

                       ∥利用极轴追踪从 A点向上捕捉绘出水平线 1 

Specify next point or [Undo]： 

Specify next point or [Undo]：↙ 

Command：↙ 

LINE Specify first point：77↙           

                       ∥利用极轴追踪从 A点向上捕捉绘出水平线 2 

Specify next point or [Undo]： 

Specify next point or [Undo]：↙ 

Command：↙ 

LINE Specify first point：7↙           

                       ∥利用极轴追踪从 C点向左捕捉绘出垂直线 3 

Specify next point or [Undo]： 

Specify next point or [Undo] ↙： 

Command：↙ 

LINE Specify first point：7↙         

                   ∥利用极轴追踪从 C点向右捕捉绘出另一垂直线 4 

Specify next point or [Undo]： 

Specify next point or [Undo]：↙ 

Command：↙ 

LINE Specify first point：9↙              

                       ∥利用极轴追踪从 C点向左捕捉绘出垂直线 5 

Specify next point or [Undo]： 

Specify next point or [Undo]：↙ 

Command：↙ 

LINE Specify first point：9↙           

                   ∥利用极轴追踪从 C点向右捕捉绘出另一垂直线 6 

Specify next point or [Undo]： 

Specify next point or [Undo]：↙ 

Command：                                  如图 2-48所示 
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图 2-48  绘制已知线段 

 

    步骤四：修剪图形。修剪、倒角、绘制中间线段。操作步骤如下： 

Command：_trim                              ∥点击修剪命令 

Current settings：Projection=UCS Edge=None 

Select cutting edges ...                     ∥选择修剪边界 

Select objects：Specify opposite corner：20 found     

                                  ∥用交叉窗口选择所有直线和圆 

Select objects：↙                                

                                        互相作为修剪边界，回车 

Select object to trim or [Project/Edge/Undo]：        

                                    ∥细心修剪需要剪掉的小线段 

Select object to trim or [Project/Edge/Undo]：   

                                         ∥修剪成如图 2-49所示 

Command： 
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图 2-49  修整图形绘制中间 

 

Command：_chamfer                          ∥点击倒角命令 

(TRIM mode) Current chamfer Dist1 = 10.0000, Dist2 = 10.0000 

Select first line or [Polyline/Distance/Angle/Trim/Method]：d↙  

                                                  设置倒角参数 

Specify first chamfer distance <10.0000>：2↙    ∥输入倒角距离 

Specify second chamfer distance <2.0000>：↙              

                                      ∥回车，确认另一倒角距离 

Command：↙                                   ∥回车，开始倒角 

CHAMFER 

(TRIM mode) Current chamfer Dist1 = 2.0000, Dist2 = 2.0000 

Select first line or [Polyline/Distance/Angle/Trim/Method]：     

                                                   ∥点选直线 2 

Select second line：                               ∥点选直线 3 

Command：↙                                    ∥回车，继续倒角 

CHAMFER 

(TRIM mode) Current chamfer Dist1 = 2.0000, Dist2 = 2.0000 

Select first line or [Polyline/Distance/Angle/Trim/Method]：     

                                                   ∥点选直线 2 

Select second line：                               ∥点选直线 4 

Command： 

Command：_line Specify first point：           ∥绘制倒角处直线 

Specify next point or [Undo]： 

Specify next point or [Undo]：↙ 

Command：                                         如图 2-49所示 

    步骤五：绘制连接线段。继续修整图形，倒圆角 

Command：_fillet                              ∥点击倒圆角命令 

Current settings：Mode = TRIM, Radius = 2.0000 

Select first object or [Polyline/Radius/Trim]：r↙      

                                              ∥设置倒圆角半径 

Specify fillet radius <2.0000>：24↙              ∥输入半径值 

Command：↙                                 ∥回车，开始倒圆角 
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图 2-50  倒圆角绘制连接线段 

FILLET 

Current settings：Mode = TRIM, Radius = 24.0000 

Select first object or [Polyline/Radius/Trim]：    ∥点选直线 6 

Select second object：                               ∥点选圆 2 

Command：↙                                  ∥回车，继续倒圆角 

FILLET 

Current settings：Mode = TRIM, Radius = 24.0000 

Select first object or [Polyline/Radius/Trim]：r↙    

                                             ∥重设倒圆角半径 

Specify fillet radius <24.0000>：36↙        ∥输入新的半径值 

Command：↙                                ∥回车，开始倒圆角 

FILLET 

Current settings：Mode = TRIM, Radius = 36.0000 

Select first object or [Polyline/Radius/Trim]：   ∥点选直线 5 

Select second object：                              ∥点选圆 1 

Command： 

Command：↙                                ∥回车，继续倒圆角 

FILLET 

Current settings：Mode = TRIM, Radius = 36.0000 

Select first object or [Polyline/Radius/Trim]：r↙    

                                              ∥重设倒圆角半径 

Specify fillet radius <36.0000>：2↙           ∥输入新的半径值 

Command：↙                                ∥回车，开始倒圆角 
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FILLET 

Current settings：Mode = TRIM, Radius = 2.0000 

Select first object or [Polyline/Radius/Trim]：      ∥点选圆 3 

Select second object：                ∥点选圆 4，如图 2-50所示 

 

步骤六：整理图形，如图 2-46所示的图形。 

 

 

图 2-51  整理图形 

实训十二   绘图模板的绘制 

 

 

图 2-52  绘图模板平面图 

 

    步骤一：绘制准备。根据需要建立适当的图层，比如外形线层、文本层、刻度

线层等。选择公制和适当的绘图范围，打开绘制、编辑、对象捕捉、尺寸标注等常

用工具条，打开端点、交点、圆心等捕捉功能等。 

步骤二：绘制外形线。用多义线（又称 PL线）命令绘制一条宽度为 0.5mm的

外形线。 
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Command：_pline                                         ∥点击多义线命令 

Specify start point：52,76↙                                     ∥输入 A点 

Current line-width is 0.0000                            ∥系统显示当前线宽为 0 

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]：w↙    ∥改变线宽 

Specify starting width <0.0000>：0.5↙                     ∥输入起点线宽为 0.5 

 

 

图 2-53  绘制外形多义线 

 

Specify ending width <0.5000>：↙                     ∥回车，确认终点线宽 

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]：@100<90输入 B点 

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]：@120<0↙输入 C点 

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]：a↙     

                                                     ∥改变设置，绘圆弧 

Specify endpoint of arc or[Angle/CEnter/CLose/Direction/Halfwidth/Line 

/Radius/Second pt/Undo/Width]：@100<-90↙              ∥输入圆弧终点 D点 

Specify endpoint of arc or[Angle/CEnter/CLose/Direction/Halfwidth/Line 

/Radius/Second pt/Undo/Width]：L↙                      ∥改变设置，绘直线 

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]：c↙   ∥封闭多义线 

Command：                                               如图 2-53所示 

步骤三：绘制直尺刻度线。先在 BD边的 E点绘一条长 4mm的小线段，将该线

段阵列 101条，每条相间 1mm。同时将 10mm处的刻度线加长 2 mm，将 5 mm处

的刻度线加长 1mm形成刻度线。然后标注刻度值 

Command：_line                                     ∥点击绘制直线命令 

Specify first point：62,176↙                           ∥输入 E点 

Specify next point or [Undo]：@4<-90↙                 ∥绘一 4mm长刻度线 

Specify next point or [Undo]：↙                       ∥回车，结束 
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Command： 

Command：_array                                   ∥点击阵列命令 

Select objects：1 found                                ∥点选刻度线 

Select objects：↙                                    ∥回车，结束 

Enter the type of array [Rectangular/Polar] <R>：↙         ∥矩形阵列 

Enter the number of rows (---) <1>：↙                   ∥阵列一行 

Enter the number of columns (|||) <1> 101↙               ∥阵列 101列 

Specify the distance between columns (|||)：1↙            ∥每列间距为 1mm 

 

 

图 2-54  绘制直尺刻度线 

 

Command：                                        如图 2-54所示（上） 

Command：_lengthen                                  ∥点击加长命令 

Select an object or [DElta/Percent/Total/DYnamic]：de↙     ∥选择定长方式 

Enter delta length or [Angle] <0.0000>：1↙               ∥每点击一下加长 1mm 

Select an object to change or [Undo]：↙    将第一条刻度线加长 2 mm（点击 2下） 

……                      以后每逢 5 mm处加长 1mm，每逢 10 mm处加长 2 mm 

Command：                                        如图 2-54所示（中） 

Command：_dtext                                  ∥点击文本命令 

Current text style："Standard" Text height：5.0000 

Specify start point of text or [Justify/Style]：j↙          ∥选择对正方式 

Enter an option [Align/Fit/Center/Middle/Right/TL/TC/TR/ML/MC/MR/BL/BC/BR]：c 

                                                 ∥按中心对正 

Specify center point of text：62,165↙                 ∥输入文本中心点 

Specify height <2.5000>：3.5↙                      ∥输入文本高度 

Specify rotation angle of text <0>： ↙                ∥回车，确认文本角度 
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Enter text：0↙                                    ∥输入文本 0 

Enter text：↙                                     ∥回车，结束 

Command：                                       得到刻度值 0 

Command：_array                                 ∥阵列刻度值 0（文本） 

Select objects：1 found                              ∥点选刻度值 0 

Select objects：↙                                  ∥回车，结束 

Enter the type of array [Rectangular/Polar] <R>：↙      ∥矩形阵列 

Enter the number of rows (---) <1>：↙                 ∥阵列一行 

Enter the number of columns (|||) <1> 11↙              ∥阵列 11列 

Specify the distance between columns (|||)：10↙         ∥每列间距为 10mm 

Command：                                      如图 2-54所示（中） 

步骤四：修改刻度值。直接选中阵列后需修改的刻度值，比如第二个 0，单击

标右键，弹出快捷菜单，选择 Text Edit项，如图 2-55所示。在其后出现的 Edit Text 

（文本编辑）对话框中，将数字（文本）0改为 1，如图 2-56所示。其余修改类同。

最后得到图 2-54（下）所示的刻度值。 

    步骤五：完成直线刻度值。将上面的刻度值复制到 F点，再绕 F点旋转 180度 

Command：_copy                               ∥点击复制命令 

Select objects： Specify opposite corner：112 found   ∥窗选所有刻度值 

Select objects：↙                               ∥回车，结束选择 

Specify base point or displacement, or [Multiple]：     ∥捕捉基点 E 

Specify second point of displacement or <use first point as displacement>：@100,-100↙    

∥输入得到 F点 

Command：                                     所有刻度值已复制到 F点 

Command：_rotate                                ∥点击旋转命令 

Current positive angle in UCS：ANGDIR=counterclockwise  ANGBASE=0 

Select objects： Specify opposite corner：112 found      ∥窗选所有刻度值 

Select objects：↙                                ∥回车，结束选择 

Specify base point：：                             ∥捕捉基点 F 

Specify rotation angle or [Reference]：180↙          ∥输入旋转角度 

Command：                                     如图 2-57所示 
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图 2-55  Text Edit（文本编辑）快捷菜单 

 

 
图 2-56  Edit Text（文本编辑）对话框 

 

图 2-57  绘制完成直线刻度值 

 

步骤六：绘制量角器外刻度线。在图 2-57中的 C点处绘一长 4mm的小线段，

将该线段绕半圆心阵列 181条，每条相间 1度。按照处理直线刻度线方法，将 10度

处的刻度线加长 2 mm，将 5 度处的刻度线加长 1mm，形成量角器刻度线 

Command： _line Specify first point： 172,176↙       ∥在 C处绘制刻度线 

Specify next point or [Undo]：@4<-90↙               ∥向下绘 4 mm长直线 

Specify next point or [Undo]：↙                      ∥回车，结束 

Command： 

Command： _array                                 ∥阵列量角器外刻度线 

PDF 文件使用 "pdfFactory Pro" 试用版本创建 www.fineprint.cn

http://www.fineprint.cn
http://www.fineprint.cn


第 51 页 共 105页 

Select objects： 1 found                             ∥捕捉 C处刻度线 

Select objects：↙                                  ∥回车，结束 

Enter the type of array [Rectangular/Polar] <R>：p↙      ∥圆周阵列 

Specify center point of array：                        ∥捕捉圆弧中心 

Enter the number of items in the array：181↙            ∥沿半圆周阵列 181条 

Specify the angle to fill (+=ccw, -=cw) <360>：-180↙     ∥在 180度范围内 

Rotate arrayed objects? [Yes/No] <Y>：↙               ∥回车确认 

Command：                                       如图所示 

Command：_lengthen                               ∥加长刻度线 

Select an object or [DElta/Percent/Total/DYnamic]：de ↙  ∥选择加长方式 

Enter delta length or [Angle] <1.0000>：↙              ∥每点击一下加长 1mm 

Select an object to change or [Undo]： 

……           在每逢 5 度处加长 1mm，每逢 10 度处加长 2 mm,如图 2-58所示 

                                        

 

图 2-58  绘制量角器外刻度线 

步骤七：绘制量角器内刻度线和刻度值。内刻度线每 10度阵列一条，刻度值的

输入与修改方法同直线刻度值 

Command：_circle Specify center point for circle or [3P/2P/Ttr (tan tan radius)]： 

Specify radius of circle or [Diameter]：5↙          ∥绘制一个半径为 5 mm的圆 

Command： 

CIRCLE Specify center point for circle or [3P/2P/Ttr (tan tan radius)]： 

Specify radius of circle or [Diameter] <5.0000>：30↙ 再绘制一个半径为 30 mm的圆 

Command： 

Command：_line Specify first point：_qua of           ∥从象限点向上绘一条直线 

Specify next point or [Undo]：30↙                   ∥直线长 30 mm 

Specify next point or [Undo]：↙                     ∥回车，结束 
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Command： 

Command：_dtext                                 ∥标注刻度 

Current text style："Standard"  Text height：3.5000 

Specify start point of text or [Justify/Style]：j↙          ∥对正标注，中心对正 

Enter an option [Align/Fit/Center/Middle/Right/TL/TC/TR/ML/MC/MR/BL/BC/BR]：c

↙   

Specify center point of text：172,166↙                ∥输入标注中心点 

Specify height <3.5000>：2↙                       ∥输入标注高度 

Specify rotation angle of text <0>：↙                 ∥确认标注角度 

Enter text：0↙                                   ∥输入标注刻度值 

Enter text：↙                                    ∥回车，结束 

Command：↙                                   ∥回车，继续标注刻度 

 

 

图 2-59  绘制量角器内刻度线 

DTEXT 

Current text style："Standard" Text height：2.0000 

Specify start point of text or [Justify/Style]：j↙            ∥对正标注，中心对正 

Enter an option [Align/Fit/Center/Middle/Right/TL/TC/TR/ML/MC/MR/BL/BC/BR]：c

↙  

Specify center point of text：172,162↙                   ∥输入标注中心点 

Specify height <2.0000>：↙                            ∥确认标注高度 

Specify rotation angle of text <0>：↙                    ∥确认标注角度 

Enter text：180↙                                    ∥输入标注刻度值 

Enter text：↙                                       ∥回车，结束 

Command：                                         如图 2-59所示 

Command：_array                                   ∥点击阵列命令 

PDF 文件使用 "pdfFactory Pro" 试用版本创建 www.fineprint.cn

http://www.fineprint.cn
http://www.fineprint.cn


第 53 页 共 105页 

Select objects：1 found                               ∥点选刻度值 0 

Select objects：1 found, 2 total                         ∥点选刻度值 180 

Select objects： 1 found, 3 total                        ∥点选直线 

Select objects：↙                                   ∥回车，结束选择 

Enter the type of array [Rectangular/Polar] <R>：p↙      ∥圆周阵列 

Specify center point of array：                         ∥捕捉圆弧中心 

Enter the number of items in the array：19↙             ∥沿半圆周阵列 19条 

Specify the angle to fill (+=ccw, -=cw) <360>：-180↙     ∥在 180度范围内 

Rotate arrayed objects? [Yes/No] <Y>：↙               ∥回车确认 

Command：                                        如图 2-60所示（右） 

Command：_trim                                   ∥修剪两圆成半圆弧 

Current settings： Projection=UCS Edge=None 

Select cutting edges ...                                ∥以直线为边界 

Select objects：1 found                               ∥点选需要剪掉的部分 

Select objects：1 found, 2 total 

Select objects：↙                                   ∥回车，结束 

Command：                                        如图 2-60所示（右） 

Command：_dimcenter                              ∥点击圆心标记命令 

Select arc or circle：                                ∥点选半圆弧 

Select arc or circle：↙                              ∥回车，结束 

Command：                                        如图 2-60所示（右） 

Command：_properties                              ∥点击图形特性命令 

在弹出 Properties（图形属性）对话框后，再在图中点取需要编辑或修改的对象

（刻度值），选中对话框相应栏目（Contents），输入正确值后（90），回车，按两次

ESC 退出，完成一个刻度值修改。再点选下一个刻度值，直到完成全部修改为止。

关闭该对话框（用前面的 Edit Text对话框修改同样方便），结果如图 2-60所示。 

步骤八：绘制各种几何图形。包括各种尺寸的圆、正方形、长方形（矩形）、三

角形等。正方形和三角形可由正多边形绘制命令绘出，圆和长方形可直接绘出。注

意：要充分利用捕捉等功能，使其位置均匀，必要时可用移动、旋转等命令来调整

图形布置。分别以点（58，152）、（66，152）、（76，152）、（86，152）为圆心，以

1.5、2、2.5、3为半径绘制 4个圆；以点（60，135）、（70，135）、（84，135）为中

心，绘制外切于圆 R2、R4、R5的 3个正六边形；以点（60，120）、（70，120）、（84，

120）为中心，绘制外切于圆 R2、R4、R5的 3个正方形；以点（84，100）为中心，
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绘制外切于圆 R3的正三角形；以两对角点（58，97）、（75，106）绘制长方形。操

作步骤如下： 

Command：_circle Specify center point for circle or [3P/2P/Ttr (tan tan  

radius)]： 58,152↙                               ∥绘制圆，输入圆心，下同 

Specify radius of circle or [Diameter] <26.0000>：1.5↙    ∥绘制半径为 1.5的圆 

Command：↙                                   ∥回车，继续绘制圆 CIRCLE 

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]：66,152↙     

Specify radius of circle or [Diameter] <1.5000>：2↙      ∥绘制半径为 2的圆 

Command：↙     

CIRCLE Specify center point for circle or [3P/2P/Ttr (tan tan radius)]：76,152↙    

Specify radius of circle or [Diameter] <2.0000>：2.5↙    ∥绘制半径为 2.5的圆 

Command：↙     

CIRCLE Specify center point for circle or [3P/2P/Ttr (tan tan radius)]：86,152↙    

Specify radius of circle or [Diameter] <2.5000>：3↙      ∥绘制半径为 3的圆 

Command： 

 

 
图 2-60  在 Properties（图形属性）对话框中修改刻度值 
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Command： _polygon Enter number of sides <4>：6↙    ∥绘制正六边形 

Specify center of polygon or [Edge]：60,135↙           ∥输入正多边形中心 

Enter an option [Inscribed in circle/Circumscribed about circle] <I>：c↙ ∥外切圆方式 

Specify radius of circle：2↙                          ∥输入外切圆半径 

Command：↙                                    ∥回车，继续绘制正多边形 

POLYGON Enter number of sides <6>：↙             ∥绘制正六边形 

Specify center of polygon or [Edge]：70,135↙          ∥输入正多边形中心 

Enter an option [Inscribed in circle/Circumscribed about circle] <C>：↙ ∥外切圆方式 

Specify radius of circle：4↙                        ∥输入外切圆半径 

Command：↙                                   ∥回车，继续绘制正多边形 

POLYGON Enter number of sides <6>：↙            ∥绘制正六边形 

Specify center of polygon or [Edge]：84,135↙         ∥输入正多边形中心 

Enter an option [Inscribed in circle/Circumscribed about circle] <C>：↙ ∥外切圆方式 

Specify radius of circle：5↙                        ∥输入外切圆半径 

Command：↙                                   ∥回车，继续绘制正多边形 

POLYGON Enter number of sides <6>：4↙           ∥绘制正四边形（正方形） 

Specify center of polygon or [Edge]：60,120↙         ∥输入正多边形中心 

Enter an option [Inscribed in circle/Circumscribed about circle] <C>：↙ ∥外切圆方式 

Specify radius of circle：2↙                       ∥输入外切圆半径 

Command：↙                                  ∥回车，继续绘制正多边形 

POLYGON Enter number of sides <4>：↙           ∥绘制正四边形 

Specify center of polygon or [Edge]：70,120↙        ∥输入正多边形中心 

Enter an option [Inscribed in circle/Circumscribed about circle] <C>：↙ ∥外切圆方式 

Specify radius of circle：4↙                      ∥输入外切圆半径 

Command：↙                                 ∥回车，继续绘制正多边形 

POLYGON Enter number of sides <4>：↙          ∥绘制正四边形 

Specify center of polygon or [Edge]：84,120↙       ∥输入正多边形中心 

Specify radius of circle：5↙                      ∥输入外切圆半径 

PDF 文件使用 "pdfFactory Pro" 试用版本创建 www.fineprint.cn

http://www.fineprint.cn
http://www.fineprint.cn


第 56 页 共 105页 

 
图 2-61  绘制各种几何图形 

Command：↙                                 ∥回车，继续绘制正多边形 

POLYGON Enter number of sides <4>：3↙         ∥绘制正三边形（三角形） 

Specify center of polygon or [Edge]：84,100↙       ∥输入正多边形中心 

Enter an option [Inscribed in circle/Circumscribed about circle] <C>：↙ ∥外切圆方式 

Specify radius of circle：3↙                     ∥输入外切圆半径 

Command：_rectang                            ∥绘制长方形（矩形） 

Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/Width]：58,97↙     

∥输入长方形一对角点 

Specify other corner point：75,106↙               ∥输入长方形另一对角点 

Command：                                      如图 2-61所示 

步骤九：绘制曲线轮廓。根据给定的一组已知点，用直线绘制命令绘出一组折

线，如图所示；再将折线转换成多义线，最后编辑成光滑样条曲线轮廓（也可自由

定点绘出类似曲线）。已知各顶为（102,98）、（97,122）、（94,129）、（97,136）、

（ 103,141）、（ 114,126）、（ 126,155）、（ 142,155）、（ 155,147）、（ 165,130）、

（ 166,125）、（ 165,122）、（ 160,121）、（ 155,124）、（ 158,126）、（ 153,130）、

（ 147,126）、（ 152,122）、（ 151,118）、（ 145,113）、（ 139,118）、（ 144,124）、

（ 138,129）、（ 131,130）、（ 125,124）、（ 141,110）、（ 124,102）、（ 129,117）、

（114,120）、（110,98）。操作步骤如下： 

Command： _line Specify first point：102,98↙      ∥绘制一组直线，输入第一点 

Specify next point or [Undo]：97,122↙             ∥绘制直线，输入第 1点 

……                                               …… 

Specify next point or [Close/Undo]：110,98↙        ∥绘制直线，输入第 30点 
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Specify next point or [Close/Undo]：c↙             ∥封闭 

Command：                                     如图 2-62所示 

Command：pedit↙                               ∥多义线编辑命令 

Select polyline：                                  ∥点选任一直线段 

Object selected is not a polyline 

Do you want to turn it into one? <Y>↙              ∥确认将直线段转换成多义线 

Enter an option [Close/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype  

gen/Undo]：j↙                                   ∥直线段转换成多义线 

Select objects：Specify opposite corner：30 found       ∥窗选所有直线段 

Select objects：↙                                 ∥回车，结束选择 

29 segments added to polyline                      ∥所有直线段已转换成多义线 

Enter an option [Open/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype  

gen/Undo]：s↙                                    ∥将多义线转换成样条线 

Enter an option [Open/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype gen/Undo]：↙  

                                                  ∥回车，结束 

            
图 2-62  绘制曲线轮廓  

实训十三 图案填充 

[目的要求]：掌握图案填充命令 HATCH 

一、 填充图案 

步骤 1：画多义线（参考课本“图 3-43”） 
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Command：pline 

From point：p1  捕捉轮廓线上 P1点 

Current line-width is 0.0000 

Arc/Close/Halfwidth/Length/Undo/Width/<Endpoint of line>：P2 

                                                输入 P2点 

Arc/Close/Halfwidth/Length/Undo/Width/<Endpoint of line>：P3 

                                                 输入 P3点 

Arc/Close/Halfwidth/Length/Undo/Width/<Endpoint of line>：P4 

                                                                               

输入 P4点 

Arc/Close/Halfwidth/Length/Undo/Width/<Endpoint of line>：P5 

                                                 输入 P5点 

Arc/Close/Halfwidth/Length/Undo/Width/<Endpoint of line>：P6 

                                                                                                  

输入 P6点   

Arc/Close/Halfwidth/Length/Undo/Width/<Endpoint of line>：enter 

                                                    回车结束命

令 

步骤 2．将多义线进行曲线拟合 

Command ：Pedit                           启动 Pedit命令 

Select polyine：L                                选择多义线 

Close/Join/Width/Edit vertex/Fit/Spline/Undo/exit<x>：F   
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                                               键入 F 进行曲线拟

合 

Close/Join/Width/Edit vertex/Fit/Spline/Undo/exit<x>：回车 

                                                    结 束 Pedit

命令 

步骤 3．裁剪轮廓线。 

Command：Trim 

Select cutting edge(S)： 

Select object：                   选择多义线为裁

口 

Select object：回车                       结束裁口选

择 

<Select object to trim>/undo：P6         输入轮廓线上一

点 P6 

<Select object to trim>/undo：回车             结束 Trim命令 

步骤 4选择下拉菜单 Draw的 Hatch菜单项，弹出 Boundary Hatch对话框。 

步骤 5．选择阴影图案。 

 在 Boundary Hatch对话框中按“Pattern…”按钮，弹出 Hatch pattern 

palette 对话框，选择图案“ANSI31”，按 OK 按钮返回 Boundary Hatch

对话框。 

步骤 6．确定填充方式。阴影图案的比例因子和旋转角度。 

点击 Advanced按钮，弹出 Advanced option对话框、点击 Style弹
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出表右侧的▼，从中选择填充方式 Normal，按 OK按钮返回 Boundary Hatch

对话框。 

在标题为“Scale”编辑框中输入比例因子 5.0，在标题为“Angle”

编辑框中输入旋转角度 0。 

步骤 7．确定填充边界 

点击 Boundary Hatch 对话框中的 pick  points 按钮，选用光线追

踪法确定填充边界（封闭区间）。点击该按钮后，系统暂时隐去主对话框，

显示提示输入信息。 

Select internal point：                   拾取填充区域内部一

点 

Select internal point：                     拾取填充区域内一

点 

Select internal point：回车                          结束点的输

入 

此时，定义的填充边界虚线显示。 

步骤 8．预演填充的阴影图案 

点击 Boundary Hatch对话框的 Preview Hatch按钮，将显示填充的

阴影图案。 

步骤 9.填充的阴影图案 

点击 Boundary Hatch 对话框的 Apply按钮，正式填充阴影图案，并

退出 Boundary Hatch对话框。 

实训十四 尺寸标注 

PDF 文件使用 "pdfFactory Pro" 试用版本创建 www.fineprint.cn

http://www.fineprint.cn
http://www.fineprint.cn


第 61 页 共 105页 

[目的要求] ：1.掌握尺寸的标注 

             2.熟悉尺寸标注的编辑 

            3. 熟悉形状与位置公差标注 

一．尺寸标注步骤 

建立适用的文本标注样式 

Format→ Text Style→建立 Dim系统名称（字体：Italic.shx(斜式) 

字高：0 宽度：0.67）→Apply→ Close（如为了随时修改文本高度可设

h=0） 

建立适合尺寸标注样式 

Format→Dimension  style→ISO-25（或机械样图尺寸样式 BZ） 

①图层列表框中选取 Dim层作为尺寸标注专用图层 

Format→Layout→细实线 

例题： P113图 5-76编辑泵轴尺寸文本 

②确定图纸比例及计算尺寸文本高度（一般打印出来文本高度为 h=3.5）

文本高度=3.5/图纸比例 

如：图纸比例为 1：2即文本高度=3.5/0.5=7 

③计算全局比例因子，以统一缩放各种尺寸计算 

Format→Dimension Style→Modify→Fit→Use Overall Scale Of 

全局比例因子=文本高度/2.5=3.5/图纸比例*2.5mm=7/5图纸比例。  

如：图纸比例为 1：2，即全局比例因子为 7/5*1/2=0.7 

④Dim Style→设置尺寸线、尺寸界线、尺寸终端符号、比例因子、尺寸

格式、尺寸文本、尺寸单位、尺寸精度、公差等→Close 
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a.单位换算乘法器可在单位间进行换算（Multiplier For Alt） 

如：1m=3.28英尺 

1mm=0.03937英寸 

b.测量比例 Measurement Seale可使尺寸随时扩大倍数 

c.公差类型 

Symmetrical（对称）以“测量值±公差”标注 

Deviation（极限偏差）以“测量值+上偏差/-下偏差”标注 

Limits（极限尺寸）以“最大值/最小值”标注 

Basic（基本尺寸）以“测量值”标注 

如：标注 Deviation 形式公差Ф30-0.01+0.02 只需在 Upper Value 输入

0.02/Lower Value输入 0.01即可 

二．尺寸标注方法 

（Dimension-Linear）长度尺寸公差 MT/T（修改文本） 

（Aligned）对齐尺寸 

（Angular）角度尺寸 

（Q Linear）快速尺寸标注 

（Q Leader）快速引线标注 

 原点尺寸标注 

参考课本 P108例题图 5-69 
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三．尺寸标注编辑 

1．如修改公差Ф30
-0.01

+0.02 

步骤：a.采用 Explode爆破击碎尺寸，连续两次 

b.Ddedit修改（或 ModifyⅡ→A） 

修改尺寸 39→MФ39 

步骤：Dimedit→New→在<>前添加 M%%C符号→OK→选择尺寸“39”即可。 

形状与位置公差 

Dimension→Tolerance 

①Sym调出形位公差符号 

②Tolerance第一公差值，后面方框为材料条件（M满足最大实体状态；L

满足最小实体状态；S与表面尺寸无关） 

③Datum第一参数基准 

注释：①Projected Tolerance Zone：指在复合框后面带复合公差符号 P 

②Height：指确定标准复合形位公差的高度 

PDF 文件使用 "pdfFactory Pro" 试用版本创建 www.fineprint.cn

http://www.fineprint.cn
http://www.fineprint.cn


第 64 页 共 105页 

③Datum Identifier：指输入字母标识符 

1． 尺寸Ф30
-0.01

+0.02可直接利用多行文本输入%%c30-0.01^-0.02,再扫

黑-0.01^-0.02，转为 a/b格式，点击 ok。 

 实训十五  齿轮标注实例 
[目的要求]：以下图齿轮的零件图为例具体介绍尺寸的标注过程 

 

 

步骤一．标注线性尺寸 

Command：dimlinear↙                                     //标注分度圆直径 

Specify first extension line origin or <select object>： 

Specify second extension line origin： 

Specify dimension line location or[Mtext/Text/Angle/Horizontal/Vertical/Rotated]：t↙ 

Enter dimension text <154>：%%c154↙ 

Specify dimension line location or[Mtext/Text/Angle/Horizontal/Vertical/Rotated]：↙ 

Dimension text = 154 

Command： ↙                     //回车重复线性标注命令，标注齿顶圆直径 

Specify first extension line origin or <select object>： 
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Specify second extension line origin： 

Specify dimension line location or[Mtext/Text/Angle/Horizontal/Vertical/Rotated]： t↙ 

Enter dimension text <158>： %%c158↙ 

Specify dimension line location or[Mtext/Text/Angle/Horizontal/Vertical/Rotated]： ↙ 

Dimension text = 158 

Command：↙                                //回车重复命令，标注齿轮厚度 

Specify first extension line origin or <select object>： 

Specify second extension line origin： 

Specify dimension line location or[Mtext/Text/Angle/Horizontal/Vertical/Rotated]：t↙ 

Enter dimension text <46>：46h11↙ 

Specify dimension line location or[Mtext/Text/Angle/Horizontal/Vertical/Rotated]：↙ 

Dimension text = 46 

Command：dimlinear↙                                  //标注齿轮键槽宽度 

Specify first extension line origin or <select object>： 

Specify second extension line origin： 

Specify dimension line location or[Mtext/Text/Angle/Horizontal/Vertical/Rotated]：t↙ 

Enter dimension text <18>：18js9↙ 

Specify dimension line location or[Mtext/Text/Angle/Horizontal/Vertical/Rotated]：↙ 

Dimension text = 18  

Command：                                        标注效果如图 3-77所示 

 
图 3-77  齿轮的线性尺寸标注效果 

 

步骤二：再标注齿轮内孔直径Φ60H7 
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Command：dimdiameter↙ 

Select arc or circle： 

Dimension text = 60 

Specify dimension line location or [Mtext/Text/Angle]：t↙ 

Enter dimension text <60>：%%c60H7↙ 

Specify dimension line location or [Mtext/Text/Angle]：↙  

Command：                                   标注效果如图 3-78所示 

 

图 3-78  齿轮的直径尺寸标注效果 

步骤三：标注倒角尺寸 

qleader↙                           //标注齿轮外廓 1×45º的倒角 

Specify first leader point, or [Settings] <Settings>： //改变设置, “Leader Line & Arrow” 

选项卡中“Arrowhead”项选“None”, “Attachment”选项卡中选“Underline bottom line” 

Specify next point： 

Specify text width <0>：↙ 

Enter first line of annotation text <Mtext>：1*45%%d↙ 

Enter next line of annotation text： ↙ 

Command：qleader↙                           //标注齿轮内径 2.5×45º的倒角 

Specify first leader point, or [Settings] <Settings>：↙ 

Specify next point：    

Specify next point：    

Specify text width <0>：↙ 

Enter first line of annotation text <Mtext>： 2.5*45%%d↙ 

Enter next line of annotation text： ↙   

Command：                                        标注效果如图 3-79所示 
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图 3-79  齿轮的倒角尺寸标注效果 

 

步骤四：把标注样式建立尺寸替代，标注带公差的尺寸
2.0

04.64 +  

在尺寸样式替代的 Primary Units选项卡中将 Precision设置为 0.0，Tolerances选

项卡中选 Deviation(极限偏差)，上偏差 0.2，下偏差 0。 

Command：dimlinear↙                            //标注带公差的尺寸 2.0
04.64 +  

Specify first extension line origin or <select object>： 

Specify second extension line origin： 

Specify dimension line location or[Mtext/Text/Angle/Horizontal/Vertical/Rotated]：↙ 

Dimension text = 64.4 

Command：                                        标注效果如图 3-80所示 

 

步骤五：形位公差的标注 

Command：qleader↙             //使用快速引线命令绘制 “圆跳动” 形位公差 

Specify first leader point, or [Settings] <Settings>：S        //设置修改见前面的内容 

Specify first leader point, or [Settings] <Settings>：     //对象捕捉 40h11尺寸的箭头 

Specify next point：         //在“Symbol”对话框中选择圆跳动符号，在输入框输

入公差值 0.036，在基准输入框输入 A    

Specify next point：↙                                     //回车结束 

同理，可标注另一个齿轮“圆跳动” 形位公差，效果如图 3-81所示。 

最后，根据本节前面的内容绘制形位公差的基准符号（或调用名为“基准符号”的

外部块），调用“表面粗糙度”的块，标注表面粗糙度，并且注写技术要求和技术指
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标。（参见本章第二、第三节的内容）。标注效果如上图所示。 

 

 
图 3-81 齿轮形位公差尺寸标注效果           图 3-80 齿轮带公差尺寸标注效果 

 

实训十六   块的创建 

[目的要求] 熟悉块的创建 

一、 图块的创建与插入 

（一）、创建图块对话框（Block  Definition）对于经常遇到的图形和符

号,可创建为块,如:表面粗糙度、位置公差基准符号、零件的编写序号、

各种螺纹连接件的绘制、标题栏等。 

1.调用方式 

Draw --Block--Make,调出 Block   Definition （定义图块）对话框，

将指定对象定义为块，出现一个编辑属性对话框（Edit Attributes），填

写所有属性内容。 

(二）插入图块对话框（insert）、Insert--Block或健入 Insert 
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如果要修改块中对象，可选中 Explode (爆炸)使块分解。 

 

(三)．表面粗糙度的创建（细实线） 

1．以 wblock（外部块）命令制作“表面粗糙度”文件 

 注意：block为内部块，一旦退出系统，其定义也随之消失。 

2．定义表面粗糙度 Draw --Block-- Definition Attributes（或健入

ATTDEF），其中 Insertion Point 用于定义插入点的坐标，单击 pick 

point--指定表面粗糙度 B--OK--保存为 CCD块文件。 

3． 修改 Ra内容及文件 

MODIFY--TEXT（或健入 DDTEXT），如 Ra 内容出现“？？”现象

--FROMAT--TEXT STYLE--修改文体 

实训十七   文本的输入与编辑 

[目的要求] 1.掌握文本的输入与编辑 

一、文本样式的创建与设置 

1．文本样式对框（Text  style） 

Format--Text style 出现文本设置对话框 

Style  name 设为“工程字”（用 New按钮） 

Font  name 设为“仿宋”，Height设为“0”（利用命令行提示高度的值） 
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Effects  取常规，Width  Faetor取 0.707点击 Apply，再关闭。 

注：如输入汉字部分字体设为“仿宋”，“黑体”等；如输入“Ø”符号，

字体应设为.shx字体格式. 

二、文本的输入与编辑 

1．单行文本输入 

Draw--Text--Single  Line  Text 

输入文本“计算机应用”或“计算机软件开发中心”等字样 

可设单行文本“Align”（两点连线为基线，字体写在两指定点间）、“Fit” 

（指定高度为两点距离）、“TL” “ML” “BL”等对齐方式。 

2．多行文本设置 

Draw--Text--Multiline text 或“A”按纽。 

出现多行文本对话框，设由特性，属性，字间距，查找及替换方式输入所

需字体，然后进行排版。 

A．利用 CHARACTER设置多行文本字体，字高，颜色，然后 OK。 

B．利用 PROPERTIES设置多行文本的文本样式，对齐方式，宽度和旋转角。 

C．利用 LINE SPACING设置段落文字的行间距。 

D．利用 FIND/REPLACE查找与替换文字。 

E．利用 IMPORT TEXT按纽引入驱动器现有的文字文件。 

3．特殊字符的输入 

%%C：注写直径符号“¢ ” 

%%D：注写度数符号“
º
” 

%%P：注写上下偏差符号“±” 
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%%%：注写一个百分比符号“%” 

%%O：打开或关闭上划线方式 

%%U：打开或关闭下划线方式 

4．文本的编辑 

Modify→Text→Select an annotation object or[undo]:  要求选择需

要编辑的对象。 

A．如选择单行文本，出现“EDIT TEXT”对话框，修改后，单击 OK即可。 

B．如选择多行文本，出现“MULTILINE TEXT EDITOR”对话框，修改完毕，

单击 OK。 

C．选择“UNDO”，撤消最后一次的操作，再按 ENDER结束。 

MODIFY→PKOPERTIES按纽，或“A
↙
”快捷健，修改完毕。“对象特性管理

器”有两个按不同类别排列对象特性选项卡，左边 ALPHABOTIC（字母）

选项卡，右边 CATEGORIZED（分类）选项卡。 

5．标题栏的创建（字体为“长仿宋体”，字高为“3”）采用 Single填“设

计”等固定内容，如：“设计”、“制图”、“审核”、“比例”、“图号”、“数

量”等字样，其余带括号的定义为块的属性。（参考课本 p133图 6-26标

题栏） 

设计 （姓名） （日期） 图  号  

制图 （姓名） （日期） 装配代号  

审核 （姓名） （日期） 

（零件名称） 

比  例 X：Y 

批准 （姓名） （日期） 数  量 （N） 

（单位名称） 

材料： 

（材料） 共  页 第  页 

                   制图作业的标题栏 
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6．创建标题栏步骤： 

A．从 LAYER中设置 3个图层，分别为“粗实线”，“细实线”“文字”，颜

色分别为绿色、白色、红色，线宽分别为 0.7;0.35;0.35；线型均为连续

线。 

B．将“粗实线”设为当前层，画 200*60边框（用 LINE命令）。 

C．将“细实线”设为当前层，用 OFFSET命令作出相应线条。 

DRAW→TEXT→①SINGLE  LINE  TEXT （单行文本）选“MC”项 或  ②

MULTILINE  TEXT（多行文本），再输入文本。 

D．定义标题栏，填写内容属性。 

“设计”栏目，在 DRAW→BLOCK→DEFINE   ATTRIBUTES输入属性“标记”

为（姓名），提示（M）为“设计者姓名”，文字选项取“中间”，文字样式

为“工程字”，然后拾取点 P后按 ENDER回到“属性定义”，然后按 OK。 

E．建立标题栏图块 

COMMAND：WBLOCK（外部类型块） 

输入块名“标题栏”，选择对象：整个标题栏，插入基点，选取标题栏右

下角点，按“OK”。出现编辑属性对话框，填写属性内容，然后按确定。 

这样一个完整的带属性标题栏图块就完成了。如果想保存为样板文件，可

以用文件格式为“.DWT”保存，如果需要可直接从样板文件中调出。 

 

实训十八   零件图的绘制 

[目的要求]：熟悉零件图的绘制 

一、 零件图的绘制步骤 
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1．设置绘图环境（包括设置绘图范围和根据图元的性质建立各图层） 

A．设置绘图范围 

   如选用横装的 A4图幅，用 Limits命令设定：左下角坐标（0，0），右

下角坐标（297，210） 

B．建立图层 

① 根据 GB/T14665-1998规定，设定图层颜色线型 

 

层名 颜色 线型 线重 

O WHITE CONZINUONS 0.3 

CON (可见轮廓线) GREEB CONTINJONS  0.7 

CEN (中心线) REN CENTER  0.3 

HID (虚线) YELLOW HIDDEN  0.7 

DIM (尺寸标注) WHITE CONTEHJOUS  0.3 

HAT(剖面线) WHITE CONTEHJOUS   0.3 

TEXT (文本) WHITE CONTENJOUS  0.7 

② 在“0”图层上用 RECTANG命令画出图幅范围（如 A4图,输入两对角坐

标：左下角（0，0），右上角（297，210）。 

③ 重复 RECTANG命令，在“CON”图层上画图框，输入两对角坐标，左下

角为（25，5），右上角为（292，205），并画出标题栏边框，输入两对角

坐标：左下角（162,45），右上角（292，45）。 

④ 在“0”图层上用 LINE、OFFSET或 ARRAY命令绘制标题栏各分格式。 

⑤ 在“TEXT”图层上，用 DTEXT命令填写标题栏文字，然后赋予“HA4”

文件名存盘，以方便以后的调用。 
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注：可以将标题栏先制成块，再利用插入块命令将标题栏插入到 A4 图框

中，注意标题栏的右下角与图框图的右下角重叠。（插入图块命令 

insert--block，插入点为右下角点（采用 OSNAP方式） 

2.绘制视图 

A.轴类零件主要由一系列同轴回转体构成，将轴成水平放置的位置作为主

视图的位置，（只画上半部分，再用 mirror 命令镜像下一部分），一般不

需画其他视图。对于局部细节，可利用局部视图，局部放大图和剖面图表

示。 

B.箱体类零件,一般需要三个或更多视图表达，为了了解其内部结构，可

使用剖视图、剖面图绘制。 

 注：零件图的绘制部分可参考课本 P125图 6-12、图 6-16 

二、练习题（绘制零件图，采用 A3 图幅，留装订边，标题栏采用标准标

题栏） 
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实训十九   装配图绘制 

[目的要求] ：熟悉装配图的绘制 

一、装配图绘制步骤 

1．先画各个零件图 

2．由零件图拼画装配图 

  A．把要装配的内容用 WBLOCK命令定义为块文件。 

  B．使用 INSERT命令将图形文件插入装配图中。 

  C．使用 MOVE命令移动将图形进行正确的定位。 

  D．使用 EXPLODE将图形分解，再用 TRIM修剪多余线段。 

3．使用 AutoCAD设计中心组合装配图] 

Tools→AutoCAD   Design   Center或输入 ADCENTER命令。 

  A.单击设计中心的桌面图标（左边第一个），左侧的导航窗口将显示 

整个计算机的资源。 

  B.在相应路径找到已画好零件图，手击该文件，按下左键拖到指定位置。 

二、 实例分析  参考课本 P139图 6-29 

二． 练习题  课本练习（图 6-35  调节螺丝装配图） 
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机壳

1.调节螺母

底座

.底座

螺钉

螺钉示意图

调节

螺母

机壳

其余
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实例二十 实体建模 

 

[目的要求]：掌握实体建模方法及编辑 

一． 轴的实体建模 

   轴的实体模型比较简单，一般方法是用旋转建模工具生成实体，然

后作布尔运算开出轴上各种不同类型的工艺孔和槽。 

建立如图所示的轴的实体模型 

槽深10
50

150

R10

50 11070
5

65

 

1、绘制轴的剖面，取一半作为旋转平面。 

        

2、旋转建立实体模型： 
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Command:_regio  

                  建立剖面面域（或将剖面的边界轮廓线变为整体多义

线） 

Select objects：Specify opposite corner：13found 

Select objects： 

系统提示已提取 13个环，并创建 1个面域 

Command：_revolve   旋转实体工具 

Current wire frame density：ISOLINES=4 

Select objects：1 found   选择剖面面域 

3．建立键槽的辅助模型 

A．Extrude选择拉伸实体建模工具； 

B．采用 ISOlines控制网线数量（+View→Regen）可显示出来。 

4．在轴上开出键槽，并利用布尔运算 

建立多个视口 View→“Named  Views”装入键，调整到正确位置 

Command:_subtract                       利用减运算得到键槽 

Select objects objects: 1 found 

Select objects objects: 

Select solids and regions to subtract.. 

Select objects objects:1 found 

Select objects objects: 1 found, 2 total  选择辅助键的模型 

布尔运算后得到轴的实体模型如图 所示。 
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二、齿轮的实体建模（直齿轮） 

形体分析：外齿廓可用拉伸建模，内部齿体用旋转生成模型，最后用

布尔运算打孔。 

1.建立齿廓模型步骤： 

① 建立齿廓平面图； 

② 创建面域（或用 Pedit多义线编辑命令→join） 

③ solids→extrude，长度为 120 

④ circle画半径 150的圆 

⑤ extrude长度为 150 

⑥ view→front 

⑦ move将新建圆柱体向下移动 15，穿过齿廓模型 

⑧ subtract“差集”命令 

⑨ 进行布尔运算求差 

2.建立齿轮内部形体模型。 

根据平面图尺寸,绘出中间回转体剖面的形状，并作面域处理。 

① revolve 

② 按零件图位置和尺寸画出工艺孔和齿轮键槽，放在所需位置，并
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作布尔运算。 

3．完成齿轮的实体模型。 

① union. 

② 着色处理 

二、实例分析 

A．建立齿廓模型。 

根据零件图尺寸，绘出齿面轮廓线，创建面域或用 Pedit多义线编辑

指令将所有线条联成一体（Join选项），如图所示。 

B．点击打开“实体”工具条，单击拉伸工具按钮， 

Command：_extrude 

Current wire frame density： ISOLINES=4 

Select objects：Specify opposite corner：1 found  

                                                             选

择齿轮轮廓线 

Select objects： 

Specify height of extrusion or [Path]： 
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Specify second point：120                          给定路径长

度为 120 

Specify angle of taper for extrusion <0>：    

                    角度按缺省值零度，确认后生成齿廓的实心体

模型 

command:circle                            在模型底面中心画直径

300的圆 

specify center point for circle or [3p/2p/ttr] 

specify radius of circle or [Diametre]:150 

command:extrude                                              点

击拉伸工具 

current wire frame density:ISOLINES=4 

select object:specity opposite cornet:1 found                        

选择圆 

select object: 
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specify height of extrusion or [path]:specify second point:150 

                                          给定路径长度为 150 

specify angle of taper for extrusion<0>: 

                         确认后在齿面实心体模型中建立一个圆柱体 

command:view enter an option               将视图方向转为前视图 

[?/orthographic/delete/restore/save/ucs/window]:front 

regenerating model 

command:move                                “移动”命令 

select objects:specify opposite corner:1 found 

select objects: 

specify base point or displacement:specify second point of 

dispiacement or<use first point as displacement>:15 

                                将新建圆柱体向下移动 15，穿过齿

廓模型 

激活“实体编辑”工具条，进行布尔运算求差 

command:subtract select solids and regions to subtract from.. 

                                                    点 击

“subtract”差集命令     

select objects:1 found                                        先

选择齿面实体 

select objects: 

select solids and regions to subtract 
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select objects:1 found                                         

再选择圆柱体 

select objects:                                                 

建立新的实体 

返回东南等轴测视图，消隐观察建立的模型 

B、建立齿轮内部形体模型 

根据平面图尺寸，绘出中间回转体剖面的形状。注意边线应向中间

缩减，尺寸比齿根圆小，以免在和齿廓体合并时超出齿根 

用多义线编辑工具将各线段连联为整体或用“region”定义面域 

command:revolve 

current wire frame density:ISOLINES=4 

select objects:1 found                             

select objects:                                    

specify start point for axis of revolution or define axis 

by[object/X(axis)/Y(axis)]                           选择中心线

为旋转轴 

specify endpoint of axis: 

specify angle of revolution <360>:剖面形状旋转 360度，生成的模型

如图 

   按零件图位置和尺寸画出工艺孔和齿轮键槽，键槽形状应向中间延伸

一部分，用拉抻建模工具，给定大于齿轮厚度的任意高度建立圆柱体和长

方体模型。调整圆柱体和长方体上下位置，保证穿过齿体模型。 
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   在“实体编辑”工具条中选择差集作布尔运算，建立起齿轮中间部分

的模型。 

C、完成齿轮的实体模型 

  建立上下两个视口，分别在不同视口环境下将外部齿廓模型和内部齿体

模型重合对齐。 

Command:union        在“实体编辑”工具条单击并集工具，作布尔运

算 

select objects:1 found                                     选择

外部齿廓模型 

select objects:  1 found,2total                             选择

内部齿体模型 

select objects:                                     完成齿轮实

体模型的建立 

实训二十一 三维作图基础 

[目的要求]：掌握用户坐标系 UCS用法 

一、 要求在已经绘出的正立方体的六个表面上绘绘制 6 个圆，圆心分

别在表面的中心，并且分别相切于正方体的每一条边。 

步骤 1 设置实体捕捉功能。 

选择下拉菜单的 Tools/ohject snap settings—菜单项，弹出 osnap 

settings 对话框，打开 Midpoint开关和 Intersection开关，按 OK按钮

弹出对话框。 
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步骤 2 建立新的用户坐标系。 

 Command：UCS 

 Origin/Zaxis/Obiect/View/x/y/z/prev/save/del/?/<world> ： s

 键入 s选择 spoint选项 

 Origin point<0,0,0>：p    捕捉 P1交点为用户坐标系原

点 

 Point on positive portion of the x-axis <1.00,0.00,0.00>：P2 

捕捉 P2交点为用户坐标系的 X轴

正方向 

Point on positive –Y portion of the vcs XY Plane  

<0,00,1.00,0,00>：P3       捕捉 P3交点为用户坐标系的 Y轴正方

向 

步骤 3  利用新建立的用户坐标系在正方体的一个侧面绘画图 

Command ：circle       启动 circle 命令 

3P/2P/T7R/<center  point>：2P    键入 2P选择两点画图 
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First Point on diameter ：P7   捕捉 P3、P5 中点 P7 为直径第一

点 

Second point on diameter：P8    捕捉中点 P8为直径第二点得圆 1 

步骤 4  在三准空间复制圆 

Command：copy     启动 copy命令 

Select object：L选择新画的图 

Select object：回车  结束实体选择 

<Base point or displacement >/Multiple：P7捕捉 P2点为复制基

点 

Second point of displacement：P7   捕捉 P9点为复制目标点 

步骤 5 ： 

      ①建立 UCS→3point →以 P2为圆心，P4为 X轴点，P5为 Y轴点，

画圆规，再用 copy命令复制平行圆 

 ②建立 UCS→3point →以 P3为圆心，P5为 X轴点，P6为 Y轴点画 

      图形，再用 copy 命令复制平行圆 

实训二十二  日常用具实体造型 
[目的要求]：以汤勺为例，进行造型设计 

根据如图 6-38所示汤勺主视图、纵截面轮廓线图和横截面图的尺寸，

进行实体造型。操作步骤如下： 

PDF 文件使用 "pdfFactory Pro" 试用版本创建 www.fineprint.cn

http://www.fineprint.cn
http://www.fineprint.cn


第 87 页 共 105页 

 

图 6-38  汤勺 

    步骤一：绘图准备。新建一个图形文件，选择公制，设置适当的图层、

线型、颜色、绘图范围和绘图对象捕捉方式。 

    步骤二：绘制汤勺主视图。先分析汤勺的造型特点，上下可由一个椭

圆经修剪得到，上椭圆尺寸是 20×40，下椭圆尺寸是 8×30，两椭圆中心

距是 65。操作步骤如下： 

Command：_ellipse                                //点击绘制椭圆

命令 

Specify axis endpoint of ellipse or [Arc/Center]：      //在绘图

区任意点取一点 

Specify other endpoint of axis：20↙              //捕捉 X方向，

输入椭圆 X轴长 

Specify distance to other axis or [Rotation]：20↙        

                                  //捕捉 Y方向，输入椭圆 Y半轴长 

Command：↙ 

ELLIPSE                                       //回车继续绘制椭

圆 

Specify axis endpoint of ellipse or [Arc/Center]：      //在绘图

区任意点取一点 

Specify other endpoint of axis：8↙ //捕捉 X方向，输入椭圆 X轴长 

Specify distance to other axis or [Rotation]：15↙       
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                                 //捕捉 Y方向，输入椭圆 Y半轴长 

Command： 

Command：_line                             //绘制两椭圆中心联线 

Specify first point：                   //在绘制图区任意点取一点 

Specify next point or [Undo]：60↙    //捕捉垂直方向，输入中心距 

Specify next point or [Undo]：↙    //回车结束，如图 6-39a）所示 

Command： 

Command：_move                          //将上椭圆移到直线上端点 

Select objects：1 found                          //选中上椭圆 

Select objects：↙                               //回车结束选择 

Specify base point or displacement：  //捕捉移动基点，选椭圆中心 

Specify second point of displacement or  

<use first point as displacement>： //捕捉移动目标点，选直线端点 

Command：↙ 

MOVE                         //同上。继续将下椭圆移到直线下端点 

Select objects：1 found                          //选中下椭圆 

Select objects：↙                               //回车结束选择 

Specify base point or displacement：  //捕捉移动基点，选椭圆中心 

Specify second point of displacement or  

<use first point as displacement>： //捕捉移动目标点，选直线端点 

Command：                                       如图 6-39b）所示 

 

图 6-39  汤勺造型过程一 

 

    步骤三：绘中间联接处。中间联接处由直线组成，两直线一端点分别
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过上椭圆中心，另一端点分别相切于下椭圆轮廓两边。修剪直线和上下椭

圆，再将上椭圆与直线联接处两边倒圆角 R10。操作步骤如下： 

Command：_line                              //点击绘制直线命令 

Specify first point：                       //捕捉上椭圆中心点 O 

Specify next point or [Undo]：_tan to         //捕捉下椭圆切点 1 

Specify next point or [Undo]：↙                 //回车结束捕捉 

Command：↙                                  //回车继续绘制直线 

LINE Specify first point：                  //捕捉上椭圆中心点 O 

Specify next point or [Undo]：_tan to         //捕捉下椭圆切点 2 

Specify next point or [Undo]：↙    //回车结束，如图 6-39c）所示 

Command： 

Command：_trim                                //发出修剪命令 

Current settings：Projection=UCS Edge=None 

Select cutting edges：                         //选取修剪边界 

Select objects：1 found                        //点选上椭圆 

Select objects：1 found, 2 total               //点选下椭圆 

Select objects：1 found, 3 total               //点选直线 

Select objects：1 found, 4 total               //点选另一直线 

Select objects：↙                        //回车结束修剪边界选择 

Select object to trim or [Project/Edge/Undo]：       

                                     //选取需要剪掉的上椭圆部分 

Select object to trim or [Project/Edge/Undo]：      

                                      //选取需要剪掉的下椭圆部

分 

Select object to trim or [Project/Edge/Undo]：        

                                         //选取需要剪掉的直线段 

Select object to trim or [Project/Edge/Undo]：       

                                     //选取需要剪掉的另一直线段 

Select object to trim or [Project/Edge/Undo]：↙            

                                               //回车，结束修剪  

Command：                                           如图(6-39d）

所示 

Command：_fillet                                //发出倒圆角命令 
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Current settings：Mode = TRIM, Radius = 10.0000 

Select first object or [Polyline/Radius/Trim]：         

                                          //选取需要倒圆角的对

象 

Select second object：                //选取需要倒圆角的另一对象 

Command：↙                             //回车倒继续圆角命令 

FILLET 

Current settings：Mode = TRIM, Radius = 10.0000 

Select first object or [Polyline/Radius/Trim]： //同上，点选椭圆 

Select second object：                          //同上，点选直线 

Command：                                     如图 6-39e）所示 

    步骤四：绘制汤勺纵截面轮廓线。汤勺的纵截面轮廓线是一条光滑曲

线，构图时可选用多义线，根据坐标值或栅格点绘出。在缺少精确尺寸时，

可任选若干点拟合，用多义线 Spline 命令绘出其基本轮廓形状。操作步

骤如下： 

Command：_line Specify first point：        //绘出一条垂直基准线 

Specify next point or [Undo]：               //捕捉第一个合适点 

Specify next point or [Undo]：              //垂直捕捉第二个合适

点 

Command：↙                                 //回车，继续绘制直线 

LINE Specify first point：                  //再绘一条水平基准线 

Specify next point or [Undo]：             //捕捉第一个合适点 

Specify next point or [Undo]：            //垂直捕捉第二个合适点 

Command：                                       如图(6-40a）所示 

Command：_array                              //点击阵列直线命令 

Select objects：1 found                     //点选垂直直线 

Select objects：↙                           //回车结束选择 

Enter the type of array [Rectangular/Polar] <R>：↙    

                                        //回车，采用矩形阵列方式 

Enter the number of rows (---) <1>：↙      //回车，只需阵列一行 

Enter the number of columns (|||) <1> ：6↙    //需要阵列六列 

Specify the distance between columns (|||)：2↙     

                                      //输入每列间距，如图 6-40b 
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Command：↙                               //回车，继续阵列直线 

ARRAY 

Select objects：1 found                      //点选水平直线 

Select objects：↙                            //回车结束选择 

Enter the type of array [Rectangular/Polar] <R>：↙   

                                        //回车，采用矩形阵列方式 

Enter the number of rows (---) <1>：11↙         //需要阵列 11行 

Enter the number of columns (|||) <1>：↙      //只需阵列一列 

Enter the distance between rows or specify unit cell (---)：-10 

                                      //输入每行间距，负号为向下 

Command：                                      如图 6-40c所示 

 

图 6-40  汤勺造型过程二 

    步骤五：根据汤勺纵截面轮廓，用多义线来拟合。比如，在如图6-40d）、

6-40e）所示用小圆标记的交点 1、2、3、4、5、6、7处，用 Spline来绘

制成所需要的曲线。注意：1处要比汤勺主视图的勺尖长些。操作步骤如

下： 

Command：_spline                            //点击绘制多义线命令 

Specify first point or [Object]：           //捕捉点 1  

Specify next point：                       //捕捉点 2 

Specify next point or [Close/Fit tolerance] <start tangent>：      

//捕捉点 3 
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Specify next point or [Close/Fit tolerance] <start tangent>：      

//捕捉点 4 

Specify next point or [Close/Fit tolerance] <start tangent>：      

//捕捉点 5 

Specify next point or [Close/Fit tolerance] <start tangent>：      

//捕捉点 6 

Specify next point or [Close/Fit tolerance] <start tangent>：      

//捕捉点 7 

Specify next point or [Close/Fit tolerance] <start tangent>：↙ 

                                                //回车结束捕捉 

Specify start tangent：↙                       //回车 

Specify end tangent：↙                //回车，如图（6-40f）所示 

Command： 

    步骤六：绘制汤勺横截面图。汤勺横截面是由两段圆弧和两段直线组

成，可通过两个圆修剪而成。操作步骤如下： 

Command_circle                                         //绘制圆                                             

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]：    

                                           //任意点选一点作圆心 

Specify radius of circle or [Diameter]：15↙    //输入圆的半径 

Command： 

Command：_copy                              //向下复制另一个圆 

Select objects：1 found                              //选定圆 

Select objects：↙                                   //结束选择 

Specify base point or displacement, or [Multiple]：         

                                            //捕捉圆心作为基点 

Specify second point of displacement or  

<use first point as displacement>：2↙                

                                       //捕捉向下方向，输入距离 

Command： 

Command：_line Specify first point：                   

                                        //绘制一条过圆心的直线 

Specify next point or [Undo]： 

Specify next point or [Undo]： 
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Command：                                     如图（6-41a）所示 

 

图 6-41  汤勺造型过程三 

Command：_offset                             //向两边偏移直线 

Specify offset distance or [Through] <Through>：12.5↙         

                                                //输入偏移距离 

Select object to offset or <exit>：          //选定要偏移的直线 

Specify point on side to offset：                     //向左偏移 

Select object to offset or <exit>：          //选定要偏移的直线 

Specify point on side to offset：                    //向右偏移 

Select object to offset or <exit>：↙           //回车，结束选择 

Command：                                       如图(6-41b）所示 

最后修剪成如图 6-41c）所示图形。 

    步骤七：绘制面域。将图 6-39e）汤勺主视图和图 6-41c）汤勺横截

面图做成面域，在西南轴测方向观测。操作步骤如下： 

Command：_region                                  //点击面域命令 

Select objects：Specify opposite corner：6 found    //窗选主平面  

Select objects：Specify opposite corner：4 found, 10 total        

                                                    //窗选横截

面 

Select objects：↙                              //回车，结束选择 

2 loops extracted.                        //系统显示形成两个回路 

2 Regions created.                        //系统显示做成两个面域 

Command： 

Command：_shademode                                  //着色命令 

Current mode ： 2D wireframeEnter option [2D wireframe/3D 
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wireframe/Hidden/Flat/Gouraud/ 

fLat+edges/gOuraud+edges] <2D wireframe>：_g       //给面域着色 

Command： 

Command：_-view                                       //观察命令 

Enter an option [?/Orthographic/Delete/Restore/Save/Ucs/Window]：

_swiso 

Regenerating model.                          //西南轴测方向观察 

Command：                                         如图 6-42所示 

 

图 6-42  汤勺造型过程四 

 

    步骤八：做成三维实体。先将汤勺主视图拉伸成三维，再调整汤勺纵

截面轮廓线方向及横截面方向。操作步骤如下： 

Command：_extrude                            //点击拉伸对象命令 

Current wire frame density:  ISOLINES=4 

Select objects：1 found                            //点选主视图 

Select objects：↙                             //回车，结束选择 

Specify height of extrusion or [Path]：30↙       //输入拉伸高度 

Specify angle of taper for extrusion <0>：↙        //输入角度 0  

Command：                                        如图 6-43a)所示 

Command：_ucs                                   //设定用户坐标系 

Current ucs name： *WORLD* 

Enteranoption[New/Move/orthoGraphic/Prev/Restore/Save/Del/Apply

/?/World []<World>：_m                              //移动坐标系 

Specify new origin point <0,0,0>：            

                                  //捕捉轮廓线端点为新坐标系原

点 
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Command： 

Command：_rotate3d                 //从下拉菜单发出三维旋转命令 

Initializing... 

Current positive angle：ANGDIR=counterclockwise  ANGBASE=0 

Select objects：1 found                 //选择旋转对象，选轮廓线 

Select objects：↙                              //回车，结束选择 

Specify first point on axis or define axis by 

[Object/Last/View/Xaxis/Yaxis/Zaxis/2points]：y↙   //绕 Y轴旋转 

Specify a point on the Y axis <0,0,0>： //捕捉轮廓线端点为旋转点 

Specify rotation angle or [Reference]：-90↙     //输入旋转角度 

Command：                                 结果如图（6-43b)所示 

 

                a)               b)      

图 6-43  汤勺造型过程五 

 

Command：_ucs                            //设定新的用户坐标系 

Current ucs name：*NO NAME* 

Enteranoption[New/Move/orthoGraphic/Prev/Restore/Save/Del/Apply

/?/World] <World>：m                                //移动坐标系 

Specify new origin point or [Zdepth]<0,0,0>：      

                              //捕捉横截面下段中点为新坐标系原

点 

Command：                                     如图（6-44a)所示  

 
a)                                  b) 

图 6-44  汤勺造型过程六 
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Command：_rotate3d                             //三维旋转操作 

Current positive angle：ANGDIR=counterclockwise  ANGBASE=0 

Select objects：1 found               //选择旋转对象，点选横截面 

Select objects：↙                             //回车，结束选择 

Specify first point on axis or define axis by 

[Object/Last/View/Xaxis/Yaxis/Zaxis/2points]：x↙   //绕 X轴旋转 

Specify a point on the X axis <0,0,0>：           

                                   //捕捉横截面下段中点为旋转点 

Specify rotation angle or [Reference]：90↙     //输入旋转角度 

Command：                                       如图 6-44b)所示 

步骤九：横截面沿纵截面轮廓线（路径）拉伸。先将横截面移到纵截

面轮廓线一端，再把纵截面轮廓线作为路径，拉伸成三维实体。操作步骤

如下： 

Command：_move                                      //移动对象 

Select objects：1 found                            //选择横截面 

Select objects：↙                              //回车，结束选择 

Specify base point or displacement：        //捕捉横截面下段中点 

Specify second point of displacement or  

<use first point as displacement>：                   //捕捉端点 

Command：                                       如图（6-45a)所示 

 

               a)                                   b) 

图 6-45  汤勺造型过程七 

 

Command: _extrude                            //点击拉抻对象命令 

Current wire frame density：ISOLINES=4 

Select objects：1 found                           //选择横截面 

Select objects：↙                             //回车，结束选择 

PDF 文件使用 "pdfFactory Pro" 试用版本创建 www.fineprint.cn

http://www.fineprint.cn
http://www.fineprint.cn


第 97 页 共 105页 

Specify height of extrusion or [Path]：p↙         //沿路径拉伸 

Select extrusion path：                        //沿纵截面轮廓线 

Profile was oriented to be perpendicular to the path. 

Command：                                         如图 6-45b)所

示 

    步骤十：三维实体求交运算。先将图 6-45b)的截面体分二次移到图

6-43a)的平面体中部，再执行求交运算，注意两图要完全重叠，否则结果

不完整。操作步骤如下： 

Command：_move                               //点击移动对象命令 

Select objects：1 found                           //选择截面体 

Select objects：↙                             //回车，结束选择 

Specify base point or displacement：  

                       //捕捉截面体上部中点，如图 6-46c)所示点 A  

Specify second point of displacement or  

<use first point as displacement>：         //捕捉平面体上部中点 

Command：↙                                 //回车，继续移动对象 

MOVE 

Select objects：1 found                           //选择截面体 

Select objects：↙                              //回车，结束选择 

Specify base point or displacement：        //捕捉截面体上部中点 

Specify second point of displacement or  

<use first point as displacement>：@0,0,-15↙     //输入移动距离 

Command：                                         如图 6-46b)所

示 

Command：_intersect                       //点击求交布尔运算命令 

Select objects：1 found                            //选择截面体 

Select objects：1 found, 2 total                    //选择平面体 

Select objects：↙                              //回车，结束选择 

Command：                             求交运算结果如图 6-46a)所

示   

 步骤十一：整理图形。上下棱边倒圆角。操作步骤如下： 

Command：_fillet                              //点击倒圆角命令 

Current settings：Mode = TRIM, Radius = 10.0000 

PDF 文件使用 "pdfFactory Pro" 试用版本创建 www.fineprint.cn

http://www.fineprint.cn
http://www.fineprint.cn


第 98 页 共 105页 

Select first object or [Polyline/Radius/Trim]：r↙//设置圆角半径 

Specify fillet radius <10.0000>：0.3↙            //输入圆角半径 

 

                    a)                            b)                    

c) 

图 6-46  汤勺造型过程八 

 

   

Command：↙                             //回车，开始对棱边倒圆角 

FILLET 

Current settings：Mode = TRIM, Radius = 0.3000 

Select first object or [Polyline/Radius/Trim] //选择上部某一棱边 

Enter fillet radius <0.3000>：↙                //回车，确认半径 

Select an edge or [Chain/Radius]：c↙            //采取串联方式 

Select an edge chain or [Edge/Radius]：       //选择上部另一棱边 

Select an edge chain or [Edge/Radius]：↙       //回车，结束选择 

7 edge(s) selected for fillet.    //系统显示，上部棱边已全部倒好 

Command：↙                               //回车，继续倒下部棱边 

FILLET 

Current settings：Mode = TRIM, Radius = 0.3000 

Select first object or [Polyline/Radius/Trim] //选择下部某一棱边 

Enter fillet radius <0.3000>：↙                //回车，确认半径 

Select an edge or [Chain/Radius]：c↙            //采取串联方式 

Select an edge chain or [Edge/Radius]：       //选择下部另一棱边 

Select an edge chain or [Edge/Radius]：↙       //回车，结束选择 

6 edge(s) selected for fillet.                  

                                  //系统显示，下部棱边已全部倒好 

Command：                                       如图（6-47a)所示 
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    步骤十二：渲染着色显示。操作步骤如下： 

Command：_shademode                        //点击渲染着色命令 

Current mode ： 2D wirefram enter option [2D wireframe/3D 

wireframe/Hidden/Flat/  

Gouraud/fLat+edges/gOuraud+edges] <2D wireframe>：_g       

                                                   //选择体着色 

Command：                               最后结果如图 6-47b)所示。 

 

   a）                                   b） 

图 6-47  汤勺造型过程九 

实训二十四  由三维实体到二维工程图 

 
步骤一：打开支架.dwg文件。 

步骤二：点击 Layout1 标签，在页面设置对话框中 Plotter 

Configuration 区域 Name 下拉列表中选择 None，Plotter Style Table

区域 Name列表中也选择 None，再将页面的尺寸设为 ISO A4（297×210 mm）

后点击 OK按钮。进入了 Layout1的图纸空间，其中虚线是纸张的可打印

区域。如图 6-84所示。 

步骤三：用 Erase 删除命令将图 6-84 的大实线框（即视口）删除，

同时支架立体图也被删除了。此时图纸中没有任何视口。 

步骤四：点击 View菜单→Viewports→4 Viewports项目，为空白图

纸设置 4个视口。 

Command：_-vports 

Specify corner of viewport or  

[ON/OFF/Fit/Hideplot/Lock/Object/Polygonal/Restore/2/3/4] 

<Fit>：_4↙ 

Specify first corner or [Fit] <Fit>：回车使 4个视口平分可打印区 

Regenerating model. 
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Command： 

 

图 6-84 进入了 Layout1的图纸空间 

 

步骤五：将光标移到左上角的视口内，双击左键，左上角的视口变成

了模型空间，此时视口的边线变成粗线条。点击 View工具条 Front按钮，

使左上角的视口变成前视图。点击 Zoom Realtime按钮将支架放大。如图

6-85所示。 

 

图 6-85  支架实体的前视图 

步骤六：用同样方法将右上角的视口变成左视图，将左下角的视口变

成俯视图。此时图纸的布局如图 6-86所示。 

 

图 6-86 图纸的四个视口布局 

 

步骤七：点击 Solids 工具条 Setup Profile 图标，在俯视图视口生

成支架的俯视轮廓线。 

Command：_solprof                           //实体轮廓线命令 
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Select objects：1 found                     //点击支架俯视图 

Select objects：↙                        //回车结束选择 

Display hidden profile lines on separate layer? [Yes/No] <Y>： 

          //回车表示同意将不可见的轮廓线放在单独的图层上 

Project profile lines onto a plane? [Yes/No] <Y>：回车将轮廓线投

影到与视图平面平行并通过原点的一个平面上，生成平面轮廓线图形 

Delete tangential edges? [Yes/No] <Y>：↙    

                   //回车同意删除相切表面之间的分界线，完成操作 

One solid selected.                   //生成了支架的俯视轮廓线 

Command： 

步骤八：重复步骤七的操作过程，分别在前视图视口和左视图视口完

成支架的前视轮廓线和左视轮廓线。关闭支架实体所在的图层。将光标移

到四个视口外面双击左键，视口的分界线消失了。如图 6-87所示。 

 

图 6-87 关闭了实体所在的图层 

 

步骤九：为了使三个视图的轮廓线的比例一致，将光标分别移到前视

轮廓线上双击左键，前视图视口的边界出现了，点击 View 菜单→Zoom→

Scale项目，输入比例因子 1回车，即确定了前视轮廓线的大小。同样将

俯视轮廓线和左视图轮廓线的比例因子设为 1。这样三个视图轮廓线的比

例就一致了。将光标移到四个视口外面双击左键，视口边界消失。 

步骤十：点击 Insert菜单→External Reference项目，弹出外部参

考文件选择框，选择 AutoCAD 2000→Template→A4（landscape）.dwg文

件（注意：此文件是预先制作的，并已经保存在 AutoCAD 2000 的模板文

件夹中），点击打开按钮。弹出 External Reference对话框如图 6-88所

示。 
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图 6-88 外部参考对话框 

 

步骤十一：点击 OK按钮即可看到 A4的标题栏和图框随着光标移动。

在图纸的左下角点击左键指定插入点。然后用 Modify工具条中 Scale工

具和 Move工具使图框和标题栏的大小和位置均符合要求。如图(6-89) 

 

图 6-89 插入了图框和标题栏 

 

步骤十二：点击 File菜单→Plot项目，按照需要设置打印机和纸张

大小和方向，即可完成二维工程图的输出操作。 

 

实训二十四  由三维实体到二维工程图 
步骤一：打开支架.dwg文件。 

步骤二：点击 Layout1 标签，在页面设置对话框中 Plotter 
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Configuration 区域 Name 下拉列表中选择 None，Plotter Style Table

区域 Name列表中也选择 None，再将页面的尺寸设为 ISO A4（297×210 mm）

后点击 OK按钮。进入了 Layout1的图纸空间，其中虚线是纸张的可打印

区域。如图 6-84所示。 

步骤三：用 Erase 删除命令将图 6-84 的大实线框（即视口）删除，

同时支架立体图也被删除了。此时图纸中没有任何视口。 

步骤四：点击 View菜单→Viewports→4 Viewports项目，为空白图

纸设置 4个视口。 

Command：_-vports 

Specify corner of viewport or  

[ON/OFF/Fit/Hideplot/Lock/Object/Polygonal/Restore/2/3/4] 

<Fit>：_4↙ 

Specify first corner or [Fit] <Fit>：回车使 4个视口平分可打印区 

Regenerating model. 

Command： 

 

图 6-84 进入了 Layout1的图纸空间 

 

步骤五：将光标移到左上角的视口内，双击左键，左上角的视口变成

了模型空间，此时视口的边线变成粗线条。点击 View工具条 Front按钮，

使左上角的视口变成前视图。点击 Zoom Realtime按钮将支架放大。如图

6-85所示。 
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图 6-85  支架实体的前视图 

步骤六：用同样方法将右上角的视口变成左视图，将左下角的视口变

成俯视图。此时图纸的布局如图 6-86所示。 

 

图 6-86 图纸的四个视口布局 

 

步骤七：点击 Solids 工具条 Setup Profile 图标，在俯视图视口生

成支架的俯视轮廓线。 

Command：_solprof                           //实体轮廓线命令 

Select objects：1 found                     //点击支架俯视图 

Select objects：↙                        //回车结束选择 

Display hidden profile lines on separate layer? [Yes/No] <Y>： 

          //回车表示同意将不可见的轮廓线放在单独的图层上 

Project profile lines onto a plane? [Yes/No] <Y>：回车将轮廓线投

影到与视图平面平行并通过原点的一个平面上，生成平面轮廓线图形 

Delete tangential edges? [Yes/No] <Y>：↙    

                   //回车同意删除相切表面之间的分界线，完成操作 

One solid selected.                   //生成了支架的俯视轮廓线 

Command： 

步骤八：重复步骤七的操作过程，分别在前视图视口和左视图视口完

成支架的前视轮廓线和左视轮廓线。关闭支架实体所在的图层。将光标移

到四个视口外面双击左键，视口的分界线消失了。如图 6-87所示。 

PDF 文件使用 "pdfFactory Pro" 试用版本创建 www.fineprint.cn

http://www.fineprint.cn
http://www.fineprint.cn


第 105 页 共 105页 

 

图 6-87 关闭了实体所在的图层 

 

步骤九：为了使三个视图的轮廓线的比例一致，将光标分别移到前视

轮廓线上双击左键，前视图视口的边界出现了，点击 View 菜单→Zoom→

Scale项目，输入比例因子 1回车，即确定了前视轮廓线的大小。同样将

俯视轮廓线和左视图轮廓线的比例因子设为 1。这样三个视图轮廓线的比

例就一致了。将光标移到四个视口外面双击左键，视口边界消失。 

步骤十：点击 Insert菜单→External Reference项目，弹出外部参

考文件选择框，选择 AutoCAD 2000→Template→A4（landscape）.dwg文

件（注意：此文件是预先制作的，并已经保存在 AutoCAD 2000 的模板文

件夹中），点击打开按钮。弹出 External Reference对话框如图 6-88所

示。 

 

图 6-88 外部参考对话框 

 

步骤十一：点击 OK按钮即可看到 A4的标题栏和图框随着光标移动。

在图纸的左下角点击左键指定插入点。然后用 Modify工具条中 Scale工
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具和 Move工具使图框和标题栏的大小和位置均符合要求。如图(6-89) 

 

图 6-89 插入了图框和标题栏 

 

步骤十二：点击 File菜单→Plot项目，按照需要设置打印机和纸张

大小和方向，即可完成二维工程图的输出操作。 

实训二十四    文件输出 

〔目的要求〕：掌握视图平移 pan 、Mview（建立浮动视窗）图形的显示

缩的 ZOOM等命令使用。 

1、掌握图形极限空间设置 Limits  

2、图形空间与浮动模型空间切换 

一、 在 model空间上建立实体 1所示图形，高度为 4mm要求利用图纸

空间组织出图，图纸空间的图形极限为（24、18）并将显示范围设置

得和图形范围相同，在图纸空间上开四个浮动视区，分别为 Top Front 

Front Left Iso视图，各视区的图形缩放因子为 ZXP。 

步骤 1  进入图纸空间 

双击状态条上 Model 按钮，进入图纸空间 

步骤 2  设置图纸空间的图形极限 

PDF 文件使用 "pdfFactory Pro" 试用版本创建 www.fineprint.cn

http://www.fineprint.cn
http://www.fineprint.cn


第 107 页 共 105页 

Command：Limits      启动Limits命令，或点击Format→Drawing limits 

Reset paper space limits： 

ON/OFF/<lower left corner><0.0000,0.0000>：回车 输 入 左 下 角

0.0000 

Upper right corner <12.0000,9.0000>：24，18 输入右下角 24.18 

步骤 3 调整图纸空间的显示范围为图形极限范围 

Command：ZOOM                                 启动 ZOOM命令 

All/Center/Dynamic/Extents/Previons/Scale(x/xp)window/<Realtime

>：A                                                                                          

键入 A选择 All选项 

步骤 4 建立浮动视窗 

Command：Mview                                   输入浮动

视窗命令 

ON/OFF/Hideplot/Fit/2/3/4<First point>：4  建立四个浮动视窗 

Fit/<First point>：2，2   输入第一点坐标 2，2 

Sicond point：22,16 

步骤 5 从图纸空间切换到浮动模型空间 

 双击状态条上的 paper按钮，使按钮标识由 paper变为 Model. 

步骤 6 删除原视图 

 点击原来视图边框，然后删除。 

步骤 7 设置左上角浮动视窗为当前浮动视窗 

 移动光村进入左上角浮动视窗并按拾取按钮，该浮动视窗设置为当前
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浮动视窗。视窗边框为粗线显示。 

步骤 8 调整左上角浮动视窗内的显示比例。 

Command：zoom  启动 zoom命令 

All/Center/Dynamic/Extents/Previons/Scale(x/xp)window/<Realtime

>：zxp                                                       输

入相对图纸空间显示比例为 zxp 

步骤 9 调整当前浮动视窗内的视点 

Command：vpoint 

Rotale/<view point><2.63,-2.38,2.04>:0,-1,0   

                           输入视点 0，-1，0左上浮动视窗内显示前

视图。 

步骤 10 重复步骤 7，8，9 依次设置其他浮动视窗显示比例 zxp，视图为

俯视图（0，0，1），左视图（-1，0，0） 

步骤 11 用 pan命令调整各浮动视窗内的图形使之对齐。 

步骤 12 点击状态条上的 model按 paper.    
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